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本書では、ソフトウェアで利用できるツールや機能に関する、いくつかのチュートリアル概

要を説明します。ここでは、使用可能なすべての操作を詳細に説明するのではなく、ソフト

ウェアが実行できる一般的なワークフローの一部を説明しています。

構成

一部の機能や操作は、特定のアプリケーションやワークフローに固有のものですが、大部分

は汎用のものです。それらは、質的データを分析する際に頻繁に使用されます。このセク

ションでは、ソフトウェアの概念に加え、最も一般的で本質的な操作について一部を簡単に

紹介します。続くセクションでは、特定のワークフローへのアプローチを説明します。そこ

では、ソフトウェアに付属のサンプルデータファイルを使用します。

サンプルファイルは SCIEX OS DVD、フォルダ Extras/Example Project から入手できます。全プロ
ジェクトをコンピュータの D:\SCIEX OS DATA フォルダにコピーします。このチュートリアルの
例では、以下のサンプルファイルが使用されます：

• Bromocrip_IDA-DBS alone_T=1.wiff

• Bromocrip_IDA-DBS in plasma_T=0.wiff

• Bromocrip_IDA-DBS in plasma_T=1.wiff

• DataSET61.wiff

• DataSET62.wiff

• DataSET63.wiff

• DataSET64.wiff

• DataSET65.wiff

• DataSET66.wiff

• RP_digests. wiff

• RP_Intact.wiff

• Bromocriptine.mol

Bromocriptine ファイルは、ラットの肝臓ミクロソームを用いたインキュベーションにおける、
ネガティブモードの IDA 分析を基にしています。 Bromocrip_IDA-DBS alone_T=1.wiff は 1 時間の
時点で収集されたものです。他の 2 つのファイルは、0 時間と 1 時間の時点で収集し、血漿
に調製したものです。 Bromocriptine.mol ファイルには、ブロモクリプチンの分子構造が含まれ
ています。 DataSET61 ～ DataSET66 までのファイルは、ロラタジンとその不純物を基にしてい
ます。異なるデータセットは、異なる濃度レベルを表します。 RP_Intact.wiff ファイルは、イ
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ンタクトミオグロビンの分析からのものです。 RP_Intact.wiff ファイルは、トリプシン消化し
たミオグロビンの分析からのものです。

オプション

ソフトウェアでは、コマンドの実行結果を微調整するための、多くのオプションが用意され

ています。図 1-1に示すように、一部の機能では、 Shiftキーを押した場合にのみダイアロ
グが表示されるようにするチェックボックスも設けられています。これにより、パラメータ

の変更が不要な場合は、ダイアログに対応する必要がなくなります。これらのコマンドのメ

ニューには、上向きの矢印が含まれています。

図 1-1 オプション

ペイン

ソフトウェアでは情報の受け渡しにウィンドウを使用していますが、基本的なユーザーイン

ターフェースコンポーネントはペインです。ウィンドウには、1 つ以上のペインを表示する
こともできますが、同時にアクティブにできるのは 1 個のペインのみです。ペインは、メ
ニューやツールバーからのコマンドを受け取ります。メニューとツールバーからは、ペイン

やペインに含まれるデータを操作することができます。

ペインには、スペクトルおよびクロマトグラムなどのグラフ、ヒートマップや表に加え、よ

り専門的なビューも含めることができます。一般的な処理作業では、情報を表示するペイン

を作成したり、ペイン内に表示されるデータで作業を進めたりすることになります。すべて
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のペインには、汎用のシングルペインツールとダブルペインツールが含まれています。ほ

とんどのペインでは、各種のペインに固有のツールも追加されています。追加されたツール

は、より使用頻度の高いコマンド用のものです。

一般的なウィンドウの一例は、図 1-2に示されています。ウィンドウには、2 つのペインが
含まれています。アクティブなペイン（クロマトグラム）は、色付きの境界線とツールバー

で識別されています。

図 1-2 ウィンドウ内に表示されたペインの例

一般的なペイン操作は、汎用ペインのツールバーおよびダブルペインのツールバーに要約

されています。ペインに固有の操作は、グラフに要約されています。

汎用ペインのツールバー

汎用のシングルペイン機能を使用するには、アイコンをクリックします。
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表 1-1 汎用ペインのツールバーに表示されるアイコン

名称（ツールヒント）アイコン

このペインを削除する

アクティブなペインをウィンドウ全体に表示する

このペインを非表示にする

他のペインをすべて非表示にする

現在非表示のペインをすべて表示する

他のペインをすべて削除する（Ctrlキーを押しながらクリックすると、このペイン
より後に開いたペインのみが削除される）

注：同様のアイコンは、メニューバーのすぐ下に位置するマスターツールバーからも利用

できます。マスターツールバーのアイコンのいずれかをクリックしても、アクティブなペ

インに対して（アクティブウィンドウ内のアイコンをクリックするのと）同じ効果があり

ます。このツールバーは、アクティブペインのサイズが変更されていて一部のアイコンが

見えない場合に便利です。

このペインを削除する

複数のペインが開いている場合、このアイコンをクリックすると対応するペインが削除され

ます。ペインが1つだけしか開いていない場合、このアイコンは使用できません。

アクティブなペインをウィンドウ全体に表示する

このアイコンを使用することで、ペインの全画面表示と、元の表示サイズの間を切り替える

ことができます。ウィンドウに複数のペインがある場合、このアイコンをクリックすること

で、一時的にいずれか1つのペインに注意を向けることができます。

ウィンドウの上部には、ペインごとに別のタブが表示されます。ペインを切り替えるには、

目的のタブをクリックします。

注：ペインのタイトルが長い場合、すべてのタブは表示されない場合もあります。それら

をスクロールするには、タブの右側にある矢印ボタンを使用します。ペインをすべて表示

し、元の表示に戻るには、もう一度アイコンをクリックします。
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図 1-3 ペインを全画面表示した例

このペインを非表示にする

このアイコンを使用すると、対応するペインが非表示になり、ウィンドウ内で利用可能なス

ペースを他のペインで埋めることができます。このアイコンは、ペインのサブセットを表示

する場合に、他のペインを恒久的に削除したくないときに便利です。

他のペインをすべて非表示にする

（対応ペインを除く）ペインをすべて非表示にするには、このアイコンを使用します。この

アイコンをクリックした結果は、 Expands active pane to fill window（アクティブなペイ
ンをウィンドウ全体に表示する）アイコンをクリックしたときと似ています。どちらの場合

も、対応するペインのみが残り、使用可能な領域全体に表示されます。効果の違いは、別の

ウィンドウが後に作成された場合に出ます。拡大ウィンドウの場合は、新しいウィンドウが

アクティブになり、利用可能な表示領域を埋めます。非表示ペインの場合は、2 つのウィン
ドウ（元のアクティブウィンドウと新しいウィンドウ）の両方が表示されます。

現在非表示のペインをすべて表示する

非表示のペインをすべて表示するには、このアイコンを使用します。

他のペインをすべて削除する

Ctrlキーを同時に押さずにこのアイコンをクリックすると、対応するペインを除くウィンドウ
内のすべてのペインが削除されます。このオプションは、画面を整理してサンプルを再処理

する場合に便利です。また、非表示になっているペインもすべて削除されます。
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Ctrlキーを押しながらこのアイコンをクリックすると、対応するペインの後に開いたペインの
みが削除されます。このオプションは、多くのペインが開いており、最初に開いたいくつか

のペインのみが必要な場合に便利です。この場合、非表示のペインは削除されません。

ダブルペインのツールバー

ダブルペインの機能を利用する（可用性はペインの種類に依存）には、アイコンをドラッグ

します。アイコンを選択した方のペインがソースペインになり、もう一方のペインがター

ゲットペインになります。

表 1-2 ダブルペインのツールバーに表示されるアイコン

名称（ツールヒント）アイコン

ドラッグアンドドロップによりペインを再配置します。

このアイコンを別のグラフにドラッグすると、アクティブデータが他方のグラ

フのアクティブデータに加算されます。（Ctrlキーを押しながらドラッグすると、
アクティブデータが他方のグラフのすべてのデータセットに加算されます。）

このアイコンを別のグラフにドラッグすると、アクティブデータが他方のグラ

フのアクティブデータから減算されます。（Ctrlキーを押しながらドラッグする
と、ターゲットのすべてのデータセットから減算されます。負の値を維持する

には、Shift キーを押し続けます。）

ターゲットのグラフにアクティブデータを重ね合わせるには、別のグラフへド

ラッグします。（Ctrlキーを押しながらドラッグすると、アクティブなデータ
セットだけでなくすべてのデータセットが重ね合わされます。）

ドラッグアンドドロップによりペインを再配置する

このアイコンは各ペインの右上に表示されており、ペインの相対位置を変更するために使用

されます。 1つのペインのアイコンをクリックして、第2のペインの上、下、左、または右側
部分にドラッグします。マウスを離した場所に応じて、最初のペインが第2のペインに対し
て相対的な位置に変更されます。カーソルをドラッグすると、第2のペインのいずれかの辺が
赤で強調表示されます。これは、最初のペインがどこに配置されるかを示します。図 1-4は、
上部のペインから、下部のペインの右側部分にこのアイコンをドラッグした結果です。
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図 1-4 上部のペインから、下部のペインの右側部分にこのアイコンをドラッグした結果

注：ウィンドウ間でペインをドラッグすることもできます。

別のグラフにドラッグしてアクティブデータを他のグラフのアクティブデータに加算

する

2 つのデータセットを合計するには、ポイントごとにこのアイコンを使用します。（最初に
クリックされたペインの）ソースデータは、（アイコンがリリースされたペインの）ター

ゲットデータに追加されます。変更対象データのタイトルが更新され、データが変更された

ことを示します。

注： 同じ種類の2つのデータセットのみを加算できます。たとえば、スペクトルをクロマ
トグラムに加算することはできません。

注：オーバーレイされたトレースがターゲットグラフに複数含まれている場合、デフォル

トでは、ソースデータはアクティブなターゲットデータに追加されます。 Ctrl キーを押す
と、ターゲット内のデータセットすべてにソースデータが追加されます。

別のグラフにドラッグしてアクティブデータをターゲットのアクティブデータから減

算する

ターゲットデータから元のデータを減算するには、このアイコンを使用します。このアイコ

ンは、質量スペクトルのバックグラウンド減算を行う場合に最も便利です。

注：オーバーレイされたトレースがターゲットグラフに複数含まれている場合、デフォル

トでは、ソースデータはアクティブなターゲットデータからのみ減算されます。 Ctrl キー
を押すと、ターゲット内のデータセットすべてからソースデータが減算されます。
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ヒント！ 通常、ソースの強度がターゲットよりも高いデータポイントは保持されません。

これは、負の Y 値が破棄されることを意味します。 Shift キーを押すと、負の強度を示すデー
タポイントが保持されます。

別のグラフにドラッグしてアクティブデータをターゲットグラフに重ね合わせる

このアイコンを使用することで、ターゲットグラフ上にソースグラフ内のアクティブデータ

を重ね合わせることができます。操作が完了すると、ターゲットグラフは、ターゲットデー

タのコピーを含む新しい系列を含んだ状態になります。

注：ソースグラフに複数の重ねトレースが含まれている場合、デフォルトでは、そのアク

ティブデータのコピーのみがターゲットグラフに移動されます。 Ctrl キーを押した場合、
ソースグラフ中のデータセットすべてのコピーが、ターゲットグラフ上に重ねて表示され

ます。

グラフ

[Graphs] ペインでは、データの可視化と相互作用を行います。いくつかの操作はすべてのグ
ラフに共通ですが、表示データの種類に応じて変わる操作もあります。

図 1-5 グラフ
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一般的なコマンドを要約すると、以下のようになります。

• ズームやスクロールするには、グラフの X 軸または Y 軸のいずれかの方向にカーソルをド
ラッグします。ダブルクリックすると、軸の表示範囲が元の状態に戻ります。また、Shift
キーを押しながら軸をクリックすると、グラフを前の表示状態に戻します（ズームやスク

ロールするには、この操作を取り消します）。

• しきい値インジケータは、ドラッグして配置することができます。しきい値は通常、ど

のピークが標識されているかを判別します。また、どのピークが処理されているかを判断

するために使用される場合もあります。

• 選択するには、データ領域内をドラッグします。選択範囲は、使用または処理されるデー

タの一部を定義するために使用されます。複数の領域を選択するには、 Shiftキーを押し
ながらドラッグします。 X 軸と Y 軸の両方で同時に選択するには、Ctrlキーを押します。

グラフ固有のツールバー

表 1-3 グラフ固有のツールバーのアイコン

名称（ツールヒント）アイコン

拡大表示したグラフを初期表示に戻す

選択範囲を拡大して全体に表示する

（現在のズーム状態を表示するため）グラフの「拡大表示」を表示します。図

1-6を参照してください。

選択したピークに矢印マーカーを追加する

Y 軸（パーセント）を使用します。

オーバーレイされたすべてのトレースにラベルを付ける

ピークを塗りつぶす

グラフの X 軸を、ウィンドウ内の他のグラフ（単位が同じ）にリンクさせます。
現在のグラフすべてに適用するには、Control キーを併用します。

前の実験のデータに切り替える

次の実験のデータに切り替える

選択した実験のデータに切り替える

選択範囲のスペクトルを表示する

バックグラウンド減算範囲を設定する
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注： [Deletes this pane] のアイコンで始まる、ツールバーの最後尾にあるアイコン 6 個につい
ては、汎用ペインのツールバーに記載されています。

拡大表示したグラフを初期表示に戻す

図が拡大表示されている場合、このアイコンを使用して初期表示に戻します。初期表示では、

X 軸と Y 軸の両方についてデフォルトの範囲が表示され、利用可能なデータがすべて表示さ
れます。 X 軸をダブルクリックすると、グラフが初期表示に戻ります。 Y 軸をダブルクリッ
クすると、Y 軸についてのみ全範囲を表示します。

選択範囲を拡大して全体に表示する

このアイコンを使用すると、プロットを拡大表示し、利用可能なスペース全体を選択領域で

埋めることができます。このアイコンを選択する前に、プロットの内側をドラッグして特定

範囲を選択します。また、プロットのX軸（またはY軸）で直接ドラッグして拡大表示するこ
ともできます。

「ズーム」グラフを表示する（現在のズーム位置を示すため）

このアイコンを使用すると、メイングラフの下にグラフのコピーを小さく表示することがで

きます（図 1-6参照）。この概要グラフには、利用可能な全範囲が常に表示されます。また、
メイングラフの拡大表示領域はピンクで表示されます。メイングラフをズームすると、それ

に従ってこの選択範囲も更新されます。

ピークの選択範囲を新しい場所にドラッグすると、必要に応じてメイングラフもスクロール

されます。選択範囲の左端または右端付近をドラッグすると、選択範囲の幅が調整されま

す。この場合は、メイングラフも必要に応じて拡大表示されます。

必要な詳細レベルに達するまでかなり拡大することも多くあるため、この機能は、高分解能

で質量スペクトルを表示する際に便利です。どれだけ拡大しても、概要グラフを見れば質量

範囲全体に対してどの領域を拡大しているかがわかります。

図 1-6 概要グラフを表示する
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選択したピークに矢印マーカーを追加する

このアイコンを使用すると、グラフ内で現在選択されている領域内で、最大ピークに矢印マー

カーを追加することができます。図 1-7は、このアイコンをクリックした後の画面です。こ
こでは、図示されるように、829 ピーク（近似）が選択されています。

図 1-7 単一の矢印マーカーを追加する

矢印には、データの参照点としての役目があります。デフォルトでは、矢印に近くないピー

クは、最寄りの矢印からの距離がラベル表示されます。最大の X 値を持つ矢印付近のピーク
は、実際の X 値がラベル表示されます。矢印の近くにあるピーク（最後のピークを除く）
は、矢印の X 値の高さに応じてラベル付けされます。図 1-7では、ピークは、829 Da 前後の
ピークは、実際のm/z値を用いて判別されています。アイソトープピークは、このピークか
らの距離で標識されます。矢印の左側のピーク（図示せず）は、負の値が表記されていた可

能性もあります。

矢印は、スペクトルに対して最も一般的に使用されています。アイソトープや、MS/MS スペ
クトルのニュートラルロスといった、予想質量の差異を決める際に便利です。図 1-8では、
ペプチドのMS/MS スペクトルが表示されています。矢印は、アミノ酸残基のニュートラルロ
スに相応する各値に追加されています。たとえば、99.02 と表記されたピークは 1050.73 Da
ピークからのバリン損失の可能性があり、隣の 114.03 と表記されたピークはアスパラギンの
追加損失の可能性がある、といった具合です。また -113.08 と表記されたピークは、129.02 と
表記されたピーク（実際の m/z 比は709 Da に近い）からのロイシン損失またはイソロイシン
損失の可能性があります。

図 1-8 複数の矢印マーカーを追加する

この相対ピーク標識を使用しない場合は、Use Arrows for Relative Peak Labelingメニュー
項目をオフにします。（図 1-9を参照。）この場合、矢印は、特に関心のあるピークをマー
クするために使用されます。
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図 1-9 [Add Arrow Marker] メニュー

矢印を別の位置にドラッグできます。矢印をプロットエリアにドラッグすると、ドラッグ操

作が取り消されます。矢印をグラフの外にドラッグすると、矢印が削除されます。また、に

示すメニューから Remove All Arrowsを選択して矢印を削除することもできます。図 1-9

パーセントY軸を使用する

このアイコンは、Y 軸のスケーリングを決定します。選択すると、各トレースの最大値が 100
% になるようにオーバーレイトレースの縮小・拡大が調製されます。オーバーレイトレー
スの絶対的な大きさが非常に異なる場合、パーセントの Y 軸を使用すると便利です。

オーバーレイされたすべてのトレースにラベルを付ける

デフォルトでは、複数のトレースがオーバーレイされている場合、アクティブなトレースの

みラベルが表示されます。トレースのすべてにラベルを付けるには、このアイコンをクリッ

クしてください。このアイコンをもう一度クリックすると、すべてのラベルが除去されて元

の表示に戻ります。

ピークを塗りつぶす

このアイコンをクリックすると、暗部と明部が交互に変化するように、アクティブデータの

ピークを表示することができます。この機能は、ピークの正確な開始位置と終了位置を確認

する場合に便利です。すべてのラベルを削除し、元の表示に戻すには、もう一度アイコンを

クリックします。

グラフのX軸をウィンドウ内の他のグラフ（単位が同じもの）にリンクさせる

2 つ以上のグラフの軸をリンクすることで、1 つのグラフで軸を拡大表示したときに、他のグ
ラフでも自動調整により同じ範囲を表示させることができます。この機能は、軸をリンクし

たグラフ間でデータを比較する場合に便利です。これに代わる比較手段は、同じグラフ内の

データセットをオーバーレイすることです。ただし、これは常に望ましい手段となるわけで

はありません。

リンクする各グラフで、Links graph's x-axis to others (with same units) in the window
（グラフのX軸をウィンドウ内の他のグラフ（単位が同じもの）にリンクさせる）アイコン
をクリックします。Ctrlキーを押しながらこのアイコンをクリックすると、アクティブなグ
ラフと同じウィンドウにあり、なおかつX軸の単位が同じであるすべての可視グラフがリンク
されます。たとえば、3つのスペクトルが表示されていて、そのうち1つのスペクトルで Ctrl
キーを押しながら Links graph's x-axis to others (with same units) in the window（グラ
フのX軸をウィンドウ内の他のグラフ（単位が同じもの）にリンクさせる）アイコンをクリッ
クした場合、3つのスペクトルすべてが相互にリンクされます。
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注：この例では、新しいスペクトルがその後生成された場合、他のグラフにはリンクされ

ません。新しいスペクトルをリンクするには、対応する Links graph's x-axis to others
(with same units) in the window（グラフのX軸をウィンドウ内の他のグラフ（単位が同
じもの）にリンクさせる）アイコンをクリックします。

デフォルトでは、グラフの X 軸のみがリンクされます。この例では、1 つのグラフが手動で
拡大表示されたときに他方のグラフは Y 軸について自動拡大し、表示画面内で利用可能なス
ペースをピークで埋めるように設定されています。

リンク済みグラフをリンク解除するには、対象のグラフ上で [Links graph’s x-axis to others
(with same units) in the window（グラフの X 軸を、ウィンドウ内の他のグラフ（単位が
同じ）にリンクさせる）]のアイコンをクリックします。この際にCtrlキーを同時に押すと、
同じウィンドウ内にある、X 軸の単位が共通するグラフすべてのリンクを解除できます。

次の実験のデータに切り替える

グラフのアクティブなデータが（最後以外の）特定の実験に関連している場合、このアイコ

ンをクリックすると、このデータを同じタイプのデータ（次の実験データを除く）に置き換

えることができます。

たとえば、実験 2 用の TIC がアクティブである場合、このアイコンをクリックすることで、
実験 3 用の TIC に切り替えることができます。指定時間からのスペクトルが実験 2 に対して
アクティブの場合、このアイコンをクリックすることで、実験 3 の同じ時間からのスペクト
ルに切り替えることができます。

前の実験のデータに切り替える

グラフのアクティブなデータが（最初以外の）特定の実験に関連している場合、このアイコ

ンをクリックすると、このデータを同じタイプのデータ（以前の実験データを除く）に置き

換えることができます。

たとえば、実験 3 用の TIC がアクティブである場合、このアイコンをクリックすることで、
実験 2 用の TIC に切り替えることができます。指定時間からのスペクトルが実験 3 に対して
アクティブの場合、このアイコンをクリックすることで、実験 2 の同じ時間からのスペクト
ルに切り替えることができます。

選択した実験のデータに切り替える

このアイコンを使用すると、実験を1つずつスクロールする代わりに、特定の実験を選択でき
ます。このアイコンをクリックすると、使用可能なすべての実験のリストを示すダイアログ

が開きます。アクティブなサンプルが強調表示されます。リスト内の実験をクリックして選

択し、 OKをクリックします。 図 1-10を参照してください。
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図 1-10 実験サンプルダイアログの選択

選択範囲のスペクトルを表示する

このアイコンを使用すると、グラフ内で選択中の時間範囲にわたって平均かされた質量スペ

クトルを生成できます。同様の結果は、選択範囲内でダブルクリックすることによっても得

ることができます。

バックグラウンド減算範囲を設定する

クロマトグラムから生成されたスペクトルについて自動バックグラウンド減算を実行するに

は、このアイコンを使用します。

スペクトル固有のツールバー

表 1-4 スペクトル固有のツールバーのアイコン

名称（ツールヒント）アイコン

選択範囲のXICを表示する
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注： [Returns zoomed graph to home view（拡大表示したグラフを初期表示に戻す）] のアイコ
ンで始まる、ツールバーの最初にある 11 個のアイコンについては、グラフ固有のツール
バーに記載されています。

注： [Deletes this pane（このペインを削除する）] のアイコンで始まる、ツールバーの最後尾
にあるアイコン 6 個については、汎用ペインのツールバーに記載されています。

選択範囲のXICを表示する

このアイコンから、グラフ内で選択中の質量範囲にわたって抽出イオンクロマトグラム（XIC）
を生成します。

オーバーレイ

グラフには、別のトレース（オーバーレイと呼ばれる）を含めることができます。これらは

軸を共有しているため、容易に比較することができます。これらは、適切なダブルペインの

アイコン（Drag to another graph to overlay the active data in the target graph（別のグ
ラフにドラッグしてアクティブデータをターゲットグラフに重ね合わせる）アイコン）をド

ラッグすることによって生成できます。また、いくつかのペイン作成コマンドによって自動

的に生成されます。クロマトグラムとスペクトルを参照してください。

図 1-11では、 Label all overlaid traces（すべての重ねトレースにラベルを表示する）アイ
コンが選択された状態で、グラフには 4 つのスペクトルが含まれています。グラフのヘッダ
領域には、2 つのスペクトルと、トレースの色を示す塗りつぶされた丸のタイトルが表示さ
れます。アクティブなトレースは太字で表示されます。このトレースはすべての処理（しき

い値データや平滑化）における対象となるため、通常はトレースにのみラベル付けが行われ

ます。タイトルの左にあるアイコンをクリックすると、アイコンが変更され、アクティブト

レースのタイトルだけが描画されるようになります。この機能は、多数のオーバーレイがあ

るときに便利です。プロセスを元に戻すには、もう一度アイコンをクリックします。トレー

スが多く存在している場合にカーソルをタイトルの上に移動させると、カーソルが両方向の

矢印に変わり、ドラッグする際はスクロールバーのような役割を果たします。これにより、

タイトルのすべてにアクセスできます。
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図 1-11 [Label all overlaid traces（すべての重ねトレースにラベルを表示する）] アイコン
が選択された状態で、4 つのスペクトルを含むグラフ

アクティブなトレースを切り替えるには、次のようないくつかの方法があります。

• タイトルの横にある、色付きの円をクリックする

• タイトル自体をクリックする

• トレース内で（トレース自体ではなく）データポイントをクリックする

オーバーレイが表示されているグラフで右クリックすると、コマンドを含むコンテキストメ

ニューが表示されます。これは、表示されたトレースを視覚的に編集する際に使用します。

Remove Active Traceおよび Remove All Traces Except Activeのオプションは、予想通り
に機能しています。

ファイルを開く

図 1-12に示すように、ソフトウェアでは異なる種類のデータファイルを開くことができま
す。また、単一または複数のサンプルを開くコマンドにも対応しています。
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図 1-12 Fileメニュー

単一のサンプルファイルを開く

Open Sampleオプションにより、 Select Sampleダイアログが表示されます。 図 1-13を参
照してください。

このダイアログでは、単一のファイルを選択することができます。結果ビューは、選択した

コマンドに応じて変化します。単一の.scan ファイルではスペクトルやトータルイオンクロマ
トグラム（TIC）を、および複数のスキャン.wiff ファイルでは TIC （1 つ以上ある場合は、全
実験の合計）が表示されます。

図 1-13 Select Sampleダイアログ
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.wiff ファイルの左にあるアイコンをクリックし、ファイル内のすべてのサンプルを表示させ、
必要なファイル名を選択します。ファイルに 1 つのサンプルだけが含まれる場合、ファイル
名を選択して OKをクリックします。

複数のサンプルファイルを開く

Open Multiple Samplesと Open Heat Map TICs from Wiffのオプションから、 Select
Samplesダイアログを開きます。図 1-14を参照してください。

左側のパネルは、フォルダを参照しファイルを指定するための Openダイアログに対応して
います。右側のパネルには、OKをクリックすると開かれるファイルが表示されます。サン
プルは、次のようにして左から右へ転送することができます。

• wiff ファイルを展開し、サンプルを選択し、右矢印をクリックします。

• wiff ファイルを展開し、サンプルを選択し、右のパネルへドラッグします。

• wiff ファイルを展開し、サンプルをダブルクリックします。

ファイルに複数のサンプルが含まれている場合は、wiff ファイルを選択して右矢印をクリッ
クする、または .wiffファイルを選択して右側のパネルにドラッグすることにより、それらを
すべて転送することができます。

サンプルは、次のようにして右から左へ転送することができます。

• wiff ファイルを展開し、サンプルを選択し、左矢印をクリックします。

• wiff ファイルを展開し、サンプルを選択し、左のパネルへドラッグします。

• サンプルをダブルクリックします。

図 1-14 Select Sampleダイアログ
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クロマトグラムとスペクトル

トータルイオンクロマトグラム（TIC：Total Ion Chromatogram）、スペクトル、および抽出イオ
ンクロマトグラム（XIC：Extracted Ion Chromatogram）は、データの分析や確認に最も広く使用
されているデータの表示形式です。各データビューの間では、ソフトウェアによってリンク

が提供されます。これにより、スペクトルを迅速に生成し、その上で XIC を生成できるよう
になり、スペクトル内のピークが 1 つ以上のクロマトグラムのピークからのものであるかど
うかを判断することができます。

トータルイオンクロマトグラム（TIC）

これは、スキャンまたはマルチスキャン wiff ファイルを開いたときに表示されるデフォルト
の表示画面です。表示されている TIC は、各スペクトル中のイオンについてすべての強度を
加算した後、保持時間の関数としての合計をプロットすることによって生成されたクロマト

グラムに相当します。

サンプルがループ実験を用いて取得された場合、表示されている TIC は、両方の実験におけ
る強度の和に相当します。これを示すために、X 軸には特別な矢印が描かれています。図
1-15を参照してください。インジケータをダブルクリックすると、新しいペインが表示され
ます。ここには、実験ごとに、個別の重ね TIC が表示されます。

図 1-15 TIC

サンプルに IDA データが含まれている場合は、IDA Explorer か、または従来の TIC のいずれか
を選択します。IDA エクスプローラでは、選択したプレカーサー質量と保持時間を視覚的に
表示することができます。従来のTICオプションを選択した場合は、IDA調査のTICとIDA依存和
のTICが別々に表示されます。

Show > Total Ion Chromatogram (TIC)をクリックすると、いつでも TIC を表示することが
できます。これにより、どの実験でも選択できるダイアログが開きます。期間 1 を選択する
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と、全実験について TIC を表示します。他のエントリは、個々のTICに対応します。複数選択
するには、 Shiftキーまたは Ctrlキーを押しながらクリックします。

スペクトル

ファイルに単一のスペクトルのみが含まれている場合は、ファイルを開いた際にそのスペク

トルが表示されます。

複数のスキャンを含むデータの場合は、クロマトグラムで範囲を選択してその内側をダブル

クリックするか、「Displays a spectrum for selection（選択範囲のスペクトルを表示す
る）」アイコンをクリックすることにより、クロマトグラムからスペクトルを導出できま

す。スペクトルを更新して新しい領域を表示するには、クロマトグラム内で選択矩形をドラッ

グします。

複数の領域を選択するには、最初の選択を完了した後、 Shiftキーを押しながらドラッグし
ます。これらの選択のいずれかをダブルクリックするか、 [Displays a spectrum for selection
（選択範囲のスペクトルを表示する）]アイコンをクリックして、スペクトルが重ねあわさ
れたスペクトルペインを新しく開きます。

IDA の場合は選択画面が表示され、依存スペクトルすべてを重ね合わせる（オーバーレイ）
か、または単に最初のスペクトルを表示するかを選択します。後者の場合、他のスペクトル

を表示するには左右の矢印キーを押します。

注：このダイアログには、[Only show again if the shift key is down（Shift キーを押した場合にの
み再び表示する）] チェックボックスがあります。

バックグラウンドを減算したスペクトルを生成するには、2 つの方法があります。

• ピーク領域とバックグラウンド領域に別々のスペクトルを生成し、[subtract two-pane（ダブ
ルペインを減算する）] のアイコンをバックグラウンドスペクトルからピークスペクトル
までドラッグします。

• クロマトグラム内で 1 つないし 2 つ選択してバックグラウンド領域を定義し、 [Set
background subtraction range（バックグラウンド減算範囲を設定する）]アイコンをク
リックします。バックグラウンド領域が定義されているときに生成されたスペクトルは、

自動的にバックグラウンド減算されます。バックグラウンド領域は、淡い赤色の選択矩

形としてクロマトグラム上に表示されます。選択矩形やスペクトルの選択範囲は、どちら

もデータ表示を変更するために移動させることができます。定義されているバックグラ

ウンド領域を消去するには、アイコンの横の矢印をクリックし、 [Clear Subtraction Range
（減算範囲を消去する）]を選択します。

注：スペクトル上で矢印マーカーを使用すると、ピークラベルを（矢印が付いた）最寄り

のピークに対して配置し、損失質量や追加質量を簡単に決定できるため便利です。複数の

オーバーレイ（重ね表示）が存在しており、かつ [Label all overlaid traces（すべての重ねト
レースにラベルを表示する）] アイコンが選択されている場合、各オーバーレイのラベルは
矢印に対して配置されます。
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抽出したイオンのクロマトグラム（XIC）

XIC は、次の 2 つの方法で生成することができます。

• [Show] > [Extracted Ion Chromatogram (XIC)]をクリックします。

この操作により、開始質量と停止質量（モードによっては、中央値と幅値）を入力できる

ダイアログが開きます。これは、コンテキストメニューから変更することができます。

コンテキストメニューを開くには、ダイアログ内を右クリックします。コンテキストメ

ニューでは、デフォルト幅の設定や、質量リストのインポート/エクスポートなどの便利
なコマンドにもアクセスできます。また、質量値を記憶させておき、（削除するまで）

自動的に入力することもできます。

• スペクトルを 1 つ以上選択し、それらをダブルクリックするか、または 1 つをクリックし
て [Displays an XIC for selection（選択範囲のXICを表示する）]アイコンをクリックしま
す。

これらの操作では、それぞれの選択に相応する XIC を生成します。デフォルトでは、プロ
グラムは各選択範囲の最大ピークを決定し、ピークについて半分の高さと高質量に相応す

る値に XIC を自動的に設定します。 Ctrlキーを押すと、全選択幅が使用できます。

いずれの場合でも、各選択につき 1 つのオーバーレイを含むグラフが表示されます。選択は
リンクに変換されます。リンクをドラッグすると、XIC が更新されます。

注：XIC は通常、全クロマトグラフ範囲に対して計算され、表示されます。この処理は、複
数の範囲が選択されており、データが高解像度の機器から生成されたもので、スキャンを

多く含むような場合には時に遅くなることがあります。この場合、XIC の範囲を制限し、ス
ペクトル生成時に使用する保持時間の前後の値に設定すると便利です。これは、 [Edit] >
[Options] > [XIC]タブをクリックし、表示されたダイアログの XIC タブから設定することが
できます

等高線図とヒートマップ

LC/MS 等高線図（Show > LC/MS Contour Pane）では、単一画面で LC/MS サンプルのデータ
すべてが表示されます。図 1-16の例では、TIC と、それに相応する等高線図が表示されてい
ます。ここでは、データがm/z比のマップとして表示されており、強度の色分けがなされた
保持時間が対比されています。ここでは色の管理メニューも表示されています。それらを非

表示にするには、ビュー内で右クリックして Show Appearance Controlsオプションをクリ
アします。等高線図とクロマトグラムの X 軸は共通しているため、それらをリンクさせるこ
とで、比較する際にズームやスクロールを一度に行うことができます。
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図 1-16 TIC と、それに相応する等高線マップ

色の管理メニューでは 256 色のパレットを使用しており、min %およびmax %によって定
義された範囲について強度が色分けされます。min %より低い強度は < minを、max %よ
り高い強度は > maxを使用して描画されます。 < minで使用する色と、それらに相応する
データが一致しない場合（この例も同様）、min %より低いデータポイントは表示されませ
ん。これは視覚的しきい値の一種で、図 1-17に示すようにプロットを簡素化することがで
きます。ここでは、min %の値が 0.5 % に増加されています。色の管理メニューに関する詳
細な情報については、システムユーザーガイドを参照してください。
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図 1-17 min% の値を 0.5 % まで増やした等高線図

低強度ピークは、max %の値を低減することによって強調できます。これによりカラーパ
レットにはより強度が低い範囲も含まれるようになりますが、この値よりも大きいピークは

すべて同じ色で表示されます。また Log Scaleチェックボックスをオンにすることでも強調
できます。 Log Scaleを有効にするには、min %にゼロ以外の値（1 や 0.1 など）を指定し、
続けてパーセント強度の対数に色を割り当てる必要があります。

ソフトウェアのマルチサンプル可視化ツールには、TIC や XIC に加え、複数のサンプルのスペ
クトルを一連の（個々の）ヒートマップとして表示する機能が含まれています。これは、サ

ンプルを比較する際に役立ちます。図 1-18は 6 個の分析試料から生成された一連の TOF クロ
マトグラムです。複数のサンプルを分析するを参照してください。
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図 1-18 ヒートマップクロマトグラム
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このセクションでは、最も一般的な処理オプションの一部を紹介します。ここで使用される

ファイルは、多くのループ実験を伴う IDA ファイルですが、この例では、簡単な LC/MS 分析
をシミュレートした最初の調査実験を使用しています。次のセクションでは、IDA の機能を
説明します。

データファイルを開く

1. メインツールバーから、 Open Sampleのアイコンをクリックします。

Select Sampleダイアログが開きます。

図 2-1 Select Sampleダイアログ

2. Sample Dataフォルダがすでに選択されていない場合は、BrowseをクリックしてSample
Dataフォルダに移動します。インストールされたデータファイルの場所については、構
成を参照してください。

3. ファイル内のすべてのサンプルを表示するには、Bromocrip_IDA-DBS alone_T=1.wiff ファイル
の左にあるアイコンをクリックします。

Bromocrip_IDA-DBS alone_T = 1.wiffファイルには、1 つのサンプルだけ含まれていま
す。

4. サンプル名を選択し、 OKをクリックします。
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これは IDA ファイルであるため、ソフトウェア上では、選択したサンプルを開く方法を指
定するように求められます。

図 2-2 IDA サンプルを開く

5. まだ選択されていない場合はAs a standard TICをクリックし、OKをクリックして に示
されるように、TIC図 2-3を生成します。

図 2-3 TIC

ペインでは、サーベイスキャン TIC（青）向けに 1 つのオーバーレイを、および加算され
た依存型スキャン（プロダクトイオンスキャン）向けにもう 1 つのオーバーレイを備えて
います。この例では、調査 TIC のみを示すよう調査データを処理したいと考えています。

チュートリアルExplorer
RUO-IDV-05-2906-JA-B30 / 121

クロマトグラムとスペクトルを使用する



1 つの実験について TIC を表示する

1. X 軸の中央にあるDouble-click to overlay individual TICs for all experiments（全実験に
ついて個々の TIC を重ね合わせるには、ここをダブルクリック）アイコンをダブルクリッ
クし、全実験の TIC を重ね合わせます。

アクティブなペインは、新しいクロマトグラムです。また、最初の実験は調査であるた

め、アクティブトレースはヘッダ内で太字のタイトルとして表示されます。

図 2-4 重ね合わせ表示した XIC

2. アクティブのクロマトグラムウィンドウ内で右クリックし、 Remove All Traces Except
Activeをクリックします。調査 TIC のみ表示されます。
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図 2-5 右クリックメニュー

3. 同じペインで、 [Deletes all other panes（他のペインをすべて削除する）]アイコンをク
リックすると、調査 TIC 以外も表示されます。

図 2-6 調査 TIC

既知の分子式に対して XIC を表示する
4分～7分の範囲に外見上小さいピークがいくつかありますが、その多くはこのデータに存在
するかなり強いバックグラウンド信号によって不明瞭になっている可能性があります。この
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サンプルは、ブロモクリプチンのミクロソームインキュベーションに対応しているため、期

待される分子イオンのm/z比をピーク位置への最初のガイドとして使用します。ブロモクリ
プチンの分子式はC32H40N5O5Brであり、これはネガティブモードのデータであるため、（M -
H）–イオンの出現が期待されます。

1. Show > Mass Calculatorsをクリックします。

2. [Mass Calculators]ペイン内の [Mass Property]タブをクリックします。

3. [Formula]フィールドに分子式を入力します。

4. 「Charge state」フィールドに -1と入力します。

5. 「‘H+’ charge agent (else electron)」を選択します。

6. [Calculate]をクリックします。

注：また、分子式から手動で 1 個の水素を除去し、「H +」の電荷エージェント（他の
電子）のチェックボックスをオンにしないことも可能です。

ダイアログが更新され、モノアイソトピックや平均といった、多くの質量値を表示しま

す。

図 2-7 [Mass Calculators] ペイン

注：これらの質量値で、アイソトープは容易に解析できます。したがって、モノアイソ

トピックm/z値が最も適切な値となります。

7. モノアイソトピック m/z値を選択し、Ctrl + Cキーを押してクリップボードに値をコピー
します。

8. 「Deletes this pane（このペインを削除する）」アイコンをクリックしてMass Calculators
ペインを削除するか、「Hides this pane（このペインを非表示にする）」アイコンをク
リックしてペインを非表示にします。

Explorerチュートリアル
33 / 121RUO-IDV-05-2906-JA-B

クロマトグラムとスペクトルを使用する



9. [Show] > [Extracted Ion Chromatogram (XIC)]をクリックし、 [Specify XIC Ranges]ダ
イアログを開きます。

図 2-8 Specify XIC Ranges ダイアログ

10. Specify XIC Rangesダイアログを右クリックし、コンテキストメニューを開きます。

11.コンテキストメニューから、以下の操作を行います。

a. Start/Stop Modeオプションが選択されていないことを確認します。これにより、XIC
値が中心値および幅として入力されます。

b. Set Default Widthをクリックし、 0.05と入力して OKをクリックします。

c. Persist Ranges for Future Useをクリックします。これにより、次回にダイアログを
開いた際は値が記憶されています。
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図 2-9 コンテキストメニュー

12. Specify XIC Rangesダイアログに戻ります。

これでダイアログが設定され、対象の XIC ごとに入力する必要があるのは 1 つの質量値の
みとなります。また、デフォルトの幅が使用されます。

13. Centerの下から最初のセルを選択し、 Ctrl +  V キーを押して、ステップ 7 でコピーした
質量値を貼り付けます。

14. OKをクリックします。

注：デフォルト幅が設定されているため、個々の値を入力する必要はありません。

ペインには、ブロモクリプチンの予想分子イオンについて、TIC と XIC が表示されます。
ここでは、いくつかのピークも表示されます。
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図 2-10 ブロモクリプチンの予想分子イオンにおける TIC と XIC

スペクトルを生成し、処理する

1. TIC ペインを非表示にし、XIC 最大のピーク付近を選択し、Displays a spectrum for selection
（選択範囲のスペクトルを表示）のアイコンをクリックします。選択範囲の平均スペク

トルが生成されます。
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図 2-11 XIC 最大のピークからのスペクトル

注：図 2-11では、Optionsダイアログ（Edit > Options) で使用可能）の Peak Labeling &
Finding タブにある Label フィールドは、Mass (Charge)に設定されています。

2. X軸の630 Da～700 Daあたりをドラッグして、この領域のスペクトルを拡大表示します。

注：この操作には、2 つのステップが必要になる場合もあります。

臭素アイソトープパターンも併せ持つ 652.2140 の期待値に非常に近い場所では、652.2199
にピークがありますが、第二の臭素アイソトープクラスターが 668.2158 以降見受けられま
す。正確なm/z比の値は、XIC で選択された正確な保持時間ウィンドウによって異なりま
す。

注：ここで用いられる表記スタイルでは、m/z比に加え、括弧内の荷電状態の推定値
（ピーク間の間隔に基づく）を表示します。また、モノアイソトピックのように見える

ピークにもアスタリスクが付いています。表記アルゴリズムは 13C 以外のアイソトープ
を認識しないので、単一荷電としての 81Br アイソトープを誤ってモノアイソトピックと
して表記してしまいます。

3. 表記スタイルをデフォルトに戻すには、 Edit > Optionsをクリックし Peak Labeling &
Findingタブを開き、 Labelフィールドの設定をMass / Chargeに変更します。

4. OKをクリックします。
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図 2-12 異なる表記スタイルを適用したスペクトル

5. スペクトルを拡大表示した状態で、652.2199 ピーク付近を選択し、 Adds arrow markers
for selected peaks（選択したピークに矢印マーカーを追加する）アイコンをクリックし
ます。

図 2-13 選択したピークに を表示するスペクトル

質量標識は選択したピークを基準にしているため、質量ピークの差異が表示されていま

す。 668.2158にあるピークのラベルは「15.9959」になります。これは酸素の質量に対応し
ており、このピークはヒドロキシブロモクリプチン代謝物であることを示唆しています。

ヒント！矢印は、別のピークにドラッグして移動することができます。また、矢印を消

去するには、矢印アイコンの横にあるリストから Remove All Arrowsを選択します。
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6. 「15.9959」ラベルのピーク付近を選択し、Displays an XIC for selection（選択範囲のXIC
を表示する）アイコンをクリックします。

7. XIC Selection Rangesダイアログで OKをクリックします。

図 2-14 XIC Selection Ranges のダイアログ

図 2-15 XIC

これは、インタラクティブな XIC を生成できる便利な方法です。デフォルトでは、XIC に
使用する幅の半分の高さが質量ピークの幅であり、選択リンクはスペクトルに示されてい

ます。

8. 選択リンクをドラッグして表示されている XIC を更新し、上記のステップを繰り返して XIC
を追加します。
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9. それらを重ね合わせるには、新しいクロマトグラムのDrag to another graph to overlay
the active data in the target graph（別のグラフにドラッグしてアクティブデータをター
ゲットグラフに重ね合わせる）アイコンをクリックし、元の XIC ペインにクロマトグラム
をドラッグします。

図 2-16 XIC のオーバーレイ（重ね合わせ）

10. 2番目のクロマトグラムペインとスペクトルを非表示にするか削除してから、重ね合わせ
たクロマトグラムをズームして4分～5分の領域を表示します。

4.4分の付近に、同時期に溶出したが保持時間は完全には同じでない2つのピーク（各XICか
ら1つずつ）があります。また、668.216 クロマトグラムにも多くのピークがあります。お
そらく他のヒドロキシ代謝物の存在を示していると考えられます。

11.クロマトグラムペインの4.40分の位置をダブルクリックし、単一スキャンからスペクトル
を生成します。
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図 2-17 単一スキャンに基づくスペクトル

XIC の破線は表示スキャンを表します（図 2-17では矢印で表されます）。この線をドラッ
グするとスペクトルが更新されるので、4.40分前後の領域を詳しく調べることができます。
（一度に 1 スキャン）移動するには前方と後方の矢印キーを使用します。 668.215 イオン
の信号が無い領域（ただし、背景の値はここでも高い）にラインを移動させることによ

り、652.214 のm/z比のピークからノイズの無いスペクトルを得ることが可能です。ただ
し、668.215 の領域については、同様の方法でノイズの無いスペクトルを得ることはでき
ません。

12.スペクトルペインを削除します。

13.クロマトグラムペインで、652 ピークの左側を含むが 668 ピークを含まない狭い領域を選
択し、 Set background subtraction range（バックグラウンド減算範囲を設定する）ア
イコンをクリックします。

選択範囲がピンク色になります。

減算範囲が定義されているときは、続いて生成されたスペクトルから自動的に減算されま

す。減算範囲を消去するには、Set Subtraction Rangeアイコンの右にある小さい矢印を
クリックし、リストから Clear Subtraction Rangeを選択します。
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14. 668 ピークの頂点を含むようクロマトグラムで別の選択を行います。その際、652 ピーク
が含まれる量を可能な限り少なくします。その後、Displays a spectrum for selection（選
択範囲のスペクトルを表示する）アイコンをクリックします。

図 2-18 バックグラウンドを差し引いた、668 ピークのスペクトル

その結果、652 ピークをほとんど含まない、668 ピークのバックグラウンドを差し引いた
スペクトルが表示されます。バックグラウンドが表示されておらず、クロマトグラムの

他の部分に移動させることもできますが、クロマトグラム中の両選択範囲は双方のスペク

トルにリンクされた状態が維持されます。スペクトル選択を移動すると、表示されてい

るスペクトルも自動的に更新されます。ただし、バックグラウンド領域を変更した場合

は、その後に生成されたスペクトルのみ更新されます。

15. Hides all other panes（他のすべてのペインを非表示にする）アイコンをクリックしま
す。単一スペクトル TIC 内をクリックし、 Deletes all other panes（他のペインをすべて
削除する）アイコンをクリックすると、TIC のみ表示されるようになります。

16. TIC ペインを削除した場合は、 Show > Total Ion Chromatogram (TIC)をクリックし、
Period 1, Experiment 1を選択して OKをクリックします。
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等高線図を使用する

データセット（クロマトグラムまたはスペクトル）の一部を表示するもう 1 つの方法は、等
高線図を使用して 1 つの実験に関する完全な概要を取得することです。等高線図は非常に多
くの情報を含むこともありますが、最良の結果を得る上では通常、表示パラメータを調整す

ることが必要となります。この場合、プレカーサー化合物は臭素化されており、等高線図に

より、臭素のアイソトープパターンを有するピークを探索することができます。

1. 単一の実験 TIC がアクティブの状態で Show > LC/MS Contour Paneをクリックします。
表示された等高線図内のツールバーから Expands active pane to fill windowアイコンを
クリックすると、このペインのみ表示されるようになります。

2. 外観管理メニュー（左下隅にあるカラーボックス）が表示されていない場合は、ペイン
を右クリックし、 Show Appearance Controlを選択します。等高線図とヒートマップ
および Reference Guideを参照してください。

図 2-19 等高線図
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ヒント！デフォルトのパラメータを使用した場合、低強度のピークとノイズが過半数を

占めるため本当のピークが不明瞭になるため、ビューはあまり役立ちません。以下の操

作によって、より良いビューを生成することができます。

• 表示する最小強度を変化させる：この強度以下のデータポイントはすべて（データが

存在しない場合と）同じ色で描画されるようになるため、結果的に表示されなくなり

ます。

• カラーマッピングを変更すると、利用可能な色が割り当てられる強度範囲が狭まり、

小さなピークの視認性が向上します。

3. min %値を 0.01に変更します。強度がベースピークの 0.01% に満たないデータポイント
がすべて表示されなくなります。

図 2-20 等高線図

データ内の構造体を詳細に表示します。空隙容量とカラム洗浄領域が明確に表示され、

保持時間すべてに存在し水平線として表示されるバックグラウンドピークが多く見受け

られます。

4. Log scaleチェックボックスを選択します。

選択した色が（ベースピーク強度の割合としての）強度の対数にマッピングされ、強度が

低いピークを強調する効果があります。たとえば、4分～4.5分のあたりにある600～700の
質量範囲を持つクラスタが強調されます。

5. この領域を選択し、 Zooms selection to full viewアイコンをクリックします。
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ヒント！また、通常の方法とは別に X 軸と Y 軸を拡大表示することも可能です。

図 2-21 等高線図

表示画面からは、この領域に多くの臭素化ピークが存在することが判別できるようになり

ます。これらのピークは、
79Br および 81Br アイソトープと、それらの 13C アイソトープに

対応する、各組 4 本の平行線によって区別することができます。

6. 色の管理設定を変えながら、ビューへの影響を試します。

7. 終了したら、ウィンドウを閉じます。

これにより、データファイルも同時に閉じられます。

概要

このセクションでは、以下のタスクについて説明されました。

• データファイルを参照して開き、TIC を表示する。

• ビューを変更し、1 つの実験のみ表示されるようにする。

• 質量電卓を使用して元素組成からイオンの質量を決定し、その質量を使用してXICを生成
する。
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• インタラクティブなスペクトルとクロマトグラムを生成し、スペクトルに矢印マーカーを

使用してピーク間の質量差を示す。

• バックグラウンド減算されたスペクトルを生成する。

• 等高線図を使用し、データセットの概要を生成する。

これらの操作は、どのような種類のデータを表示するかに関わらず、インタラクティブなデー

タ処理の基礎となります。
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IDA 実験では、1 つ以上の調査スペクトルのデータが一定の基準を満たすときに、MS/MS スペ
クトル（おそらく MS3 も含む）のデータが自動的に収集されます。パラメータでは、一定
時間にかけてプレカーサー質量（トリガーとして作用させない）を排除することで、同じ LC
ピークから複数のスペクトルを収集しないよう設定するのが一般的です。ただし、冗長なス

ペクトルを収集することも時にはあります。また、ピークが基準を満たすると同時に IDA の
トリガが起こるため、通常は LC ピークの初期部分でスペクトルが生成されます。このため、
最高品質の結果を得られない可能性もあります。

ソフトウェアには、IDA データを表示し、フィルタを適用し、処理するためのツールが含ま
れています。これらのツールについて、一部はこのセクションで説明されます。

開始する前に、開いているウィンドウをすべて閉じます。

スペクトルの表示と結合

1. メインツールバーから、 Open Sampleのアイコンをクリックします。

Select Sampleダイアログが開きます。

2. Sample Dataフォルダがすでに選択されていない場合は、BrowseをクリックしてSample
Dataフォルダに移動します。

3. Bromocrip_IDA-DBS alone_T=1.wiffファイルを選択し、 OKをクリックします。

4. Open IDA SampleダイアログでWith the IDA Explorerをクリックし、 OKをクリック
します。

ソフトウェアでは、データファイル内のスペクトルをすべて検査し、以下のグラフを生成

します。
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図 3-1 IDA ビューア

左側のパネルには、 Graphタブと Tableタブが含まれています。 Graphタブは、仮想等
高線図を表示します。この中で、すべてのデータポイントは、保持時間と、プレカーサー

イオンとして選択されていたイオンのm/z比を表します。Tableタブは、仮想等高線図上
のデータポイントを表形式で表示します。右側のパネルは、選択したデータポイントの

スペクトルを表示します。最初は、第一の MS/MS スペクトルが表示されます。

等高線図では、ピーク強度に応じた色分けが使用されます。暗い色は、より強いピーク

を示しています。ラベルは、それらがデータポイントや相互に重ならないよう、可能な

場合に描画されます。より詳細に領域を調べ、複数のラベルを表示するには、等高線図

を拡大表示します。

5. 左側のパネルで、4分～5分および640 Da～700 Daの領域を拡大表示します。この領域では、
ブロモクリプチンに関連するピークがすでに見つかっています。

左図（図 3-2）は、左側のパネルだけを示しています。現在のビューが異なる場合は、
Show Options（オプションを表示）アイコンをクリックし、 Optionsダイアログの
GeneralタブでMerge spectra with similar precursor massesのチェックボックスを外
します。

多くの MS/MS スペクトルはこの領域で収集されており、クロマトグラムのピークが非常に
狭いにも関わらず、これらのいくつかはおそらく同じピークから収集されたものです。

さらに、アイソトープクラスタ内のピークごとにMS/MSスペクトルが収集されています。

6. さらにグラフをズームして、ピーク（m/z比が 668 Da 対 672 Da）のクラスタを拡大表示し
ます。図 3-2の右側のパネルを参照してください。
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図 3-2 IDA ビューア

7. 669.2197 のピーク（上記の右パネルにアスタリスクとして表示されている）から最初のも
のを選択し、 Displays an XIC for selection（選択範囲のXICを表示する）アイコンをク
リックし、サーベイスキャンでプレカーサー質量の XIC を表示します。

当初は、ピークを選択すると、対応する MS/MS スペクトルが表示されます。
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図 3-3 サーベイスキャンにおける、プレカーサー質量向けの XIC

等高線図内のデータポイントにラベルが表示されていない場合は、その上にカーソルを移

動してm/z比と保持時間のラベルを表示させます。プロダクトイオンスキャンの時間が、
調査クロマトグラムに連動するようになります。

669.2のピークについて、最初の3回のスキャンは4.21分にある最初のXICピークに関連して
います。ここは668.2のスキャンが生成された位置でもあります。2番目の2回のスキャンは
4.27分のピークに関連しており、最後のスキャンは4.42分のピーク（669.2177/4.46）からの
ものです。4.52分の669.2ピークについてはスキャンが実施されませんでしたが、670.2ピー
クについてはスキャンが得られました。

注：スキャンは連続して実施されるため、同じサーベイスキャンで実施された場合で

も、各スキャン時間はわずかに異なります。小さいアイソトープピークは、大きなピー

クよりも先には検出されない場合があります。

8. 最初の 5 回の 669.2 スキャンの周囲に選択四角形を描画します。右クリックし、 Select
Points in Graph Selectionを選択します。
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これにより、MS/MS スペクトルすべてに対してスペクトルペインがオーバーレイで表示さ
れます。

システムでは、必要以上のスキャンを実施しています。処理するスペクトルの数を減ら

し、異なる化合物まで僅かに達しないスペクトルを統合することにより、結果の質を向上

させることができます。結合する際は、質量と保持時間の両方を基にこれらのスキャン

を決定します。

9. Show Options（オプションを表示）アイコンをクリックし、Merge spectra with similar
precursor massesチェックボックスをオンにしてからMass toleranceを 10 ppm に、お
よび RT gap toleranceを 0.03分に設定します（この分析のピークは、幅約 2 秒です）。

10. OKをクリックします。

注：ダイアログのこの部分では、XIC の抽出方法を定義することもできます。質量幅は、
計器の分解能やピーク幅と一致している必要があります。使用する時間範囲を制限する

と、処理を高速化できて便利です。

データをこのように統合すると、669.2に対する3つのピーク（4.21分、4.28分、4.46分）が
生成されます。IDA ビューアペインの最下部にあるステータスバーには、データ統合の進
行状況が表示されます。完了後は、依存スペクトルの合計数が表示されます。

11. 670.2149/4.26 でのデータポイントをクリックし、 Ctrlキーを押して 668.2162/4.27 のポイン
トをクリックします。

12. MS/MS スペクトルのペインで、 Expands active pane to fill window（アクティブなペイ
ンを拡大しウィンドウ全体に表示する）アイコン、Use percent y-axis（Y 軸（パーセン
ト）を使用）アイコン、および Label all overlaid traces（すべての重ねトレースにラベ
ルを表示）アイコンをクリックし、X 軸を拡大表示させて 340 から 680 の領域を表示しま
す。
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図 3-4 スペクトル： m/z 340 ～ 680 の領域を拡大表示

これら 2 つのプレカーサーが Br のアイソトープに対応しているため、2つの Da によって
区切られた2個一組のピークとして表示され、Br 原子を保持するイオン以外はスペクトル
が同一になります。この例では、344.0441、625.1765、および 637.1712 におけるフラグメ
ント（668.2 トレース）は Br 原子を保持しており、340.1925、367.1796、および 588.2877 で
は Br 原子を保持していません。

588.2877のピークに矢印を置き、668と670のピークにBrアイソトープの質量 + 1のラベルが
表示されることを確認します。これは、588.2877においてHBrが損失したことを示します。

13.スペクトルから矢印を削除し、 Expands active pane to fill window（アクティブなペイ
ンを拡大しウィンドウ全体に表示する）アイコンをクリックします。その後、等高線図

をズームアウトしデータポイント全体を表示します。

IDA データにフィルタを適用する
IDA Explorer では、可視化データや処理データの量を減らすのに役立つ多数のフィルタが用意
されています。これらは、このセクションで説明されています。

1. 等高線図にて、 Expands active pane to fill window（アクティブなペインを全画面表示
にする）アイコンをクリックした後、ツールバーのすぐ下にあるFiltering Controls（フィ
ルタ管理）アイコンをクリックします
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図 3-5 IDA データにフィルタを適用する

このウィンドウにあるスライダとチェックボックスはそれぞれ異なるフィルタ条件に対応

しており、これらを使用して表示するデータの量を調整できます。保持時間（Time）お
よびm/z比（m/z）は、ここで選択するか、あるいは表示を拡大することで選択できま
す。

他のフィルタは、次のとおりです。

• TIC：MS/MS スペクトル内で、ピーク合計強度の制限幅を設定します。これは通常、ノ
イズの多い小さなスキャンを除去するために使用されます。

• Quality：この値は、カウント 1 より大きい加算強度の端数です。すなわち、スペクト
ル品質の推定値として、ノイズに起因する可能性が低いことを表します。

• Int 型と一致しています。（%）：  Fragment Matchingの使用時に既知のフラグメン
トとニュートラルロスによって説明される加算強度の割合を評価します。

• Similarity：基準スペクトルが設定されているときに利用できます。この機能は、基準
スペクトル内の共通フラグメントおよびニュートラルロスに対応する加算強度の割合

を測定します。基準スペクトルを使用するを参照してください。

• Mass Defect：質量の小数部分について単一範囲を設定します。この機能は、代謝物
を見つけるのに便利です。一般的な代謝変換（O、O2など）ではプレカーサー分子から
の欠損が大きく変わることはないため、その欠損に近い範囲を指定することで、存在

し得る代謝物を特定できる場合があります。
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• Defect in Range：ソフトウェアでは、単一の質量不一致・誤差の範囲だけでなく、異
なる質量範囲に適用される不一致もいくつか定義することができます。このような範

囲が定義されている場合は、このチェックボックスにより、フィルターを適用するか

どうかを決めることができます。範囲は、OptionsダイアログのMass Defectタブで
設定されています。

• Isotope pattern：このチェックボックスを使用すると、1つ以上のアイソトープパター
ンのフィルタをMS調査データに適用できます。すなわち、選択したプレカーサーイオ
ンが目的のパターンを持つ場合にのみデータポイントが表示されます。これらのパター

ンは、 Optionsダイアログの Isotope Patternタブに定義されています。

簡易フィルタにはそれぞれ 2 つのスライダが設けられており、範囲を定義することができ
ます。いずれかのスライダをダブルクリックしてから、値を直接入力します。

2. スライダーの設定を様々な値で試すと体験できることですが、TIC（例えば 1e3）やQuality
（1）の各値は、最低値に設定した場合でも劇的な効果があります。下位の TICフィルタ
を 2e3 に、および他のフィルタをすべて 0 に設定します。

ブロモクリプチンの質量不一致・誤差は約 0.22 であるため、単純な代謝物の値がこれより
も高くなったり、あるいは相当に低くなったりする可能性はほとんどありません。

3. Mass Defectフィルタを0.18～0.23に設定すると、残存ピークの中に4.5分かつ650 Daの付
近に存在するものがあり、この領域にはm/z比が652.2211である1つのデータポイントのみ
が存在することがわかります（4.40分）。

4. Filtering Controlsの隣にあるアイコンをクリックして、フィルタ管理ツールを隠します。

ヒント！表示されるフィルタを変更するには、フィルタ領域で右クリックして Filters
を選択してから、適切なものを選択します。

基準スペクトルを使用する

1. 等高線図で、 652.2211/4.40（ブロモクリプチン自体）のデータポイントをクリックし、
Set Reference Spectrum (for Similarity Scoring)（基準スペクトルの設定（類似性スコア
リング向け））アイコンをクリックします。

注：この際は、最初のグラフを拡大表示する必要がある場合もあります。

2. Set Reference Spectrum (for Similarity Scoring)（基準スペクトルの設定（類似性スコア
リング向け））アイコンの横にある矢印をクリックし、Overlay Reference Spectrumが
選択されていることを確認します。

3. 654.2185/4.39 のデータポイントをクリックします。
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基準スペクトルが定義され、かつOverlay Reference Spectrumが選択された状態では、
スペクトルと同時に基準スペクトルも表示されるため、それらを簡単に比較することがで

きます。この方法では、遷移したピークとそうでないものを簡単に見分けることができ

るため、代謝物を扱うときに便利です。

ここまでの手順で、質量が低い臭素アイソトープのプレカーサーイオンのMS/MSスペクト
ルを基準スペクトルに設定し、質量が高い同位体のスペクトルを重ね合わせたため、画面

の表示は前述の668.2ピークと同じようになっています。すなわち、2 Da離れたピークの存
在によって、臭素を含むイオンを同定できます。

4. Expands active pane to fill window（アクティブなペインを全画面表示にする）アイコ
ンをクリックし、[Contour Plot] から Table（Filtering Controlsのすぐ下）をクリックしま
す。

注：すべての列を表示する必要がある場合、スペクトルペインを表の下に移動させます

（ドラッグアンドドロップを使用してペインのアイコンを再配置させます）。

表にはグラフィカルエクスプローラと同じ情報が表示されていますが、追加の詳細情報

も含まれています。また、フィルタ管理の操作も反映されるため、2 つのビューに同じス
ペクトルが含まれています。表はスペクトルビューにリンクされており、行を選択する

とスペクトルが更新され、列ヘッダーをクリックすると行が並び替えられます。

基準スペクトルが定義されている場合は、次の 2 つの列が追加表示されます。Delta m/z
は、基準スペクトルのプレカーサー質量と、行に相応するスペクトルのプレカーサー質量

の差異を表示します。 Similarityは、両スペクトルの類似性を示します。

5. Delta m/zをクリックして表を並び替えると、約15.995（酸素の質量）離れたいくつかの
ピークと、31.990（O2）にある1つのピークの存在に気付きます。これらは、ヒドロキシブ
ロモクリプチン代謝産物であると考えられます。

6. 関連するスペクトルを表示するには、表の行をクリックします。

注：これらのスペクトルは高い類似性値を有しており（プレカーサー質量が 2 Da 高いス
キャンでも同様の類似性が認められる）、これらは

81Br を含むイオンを基に得られてい
ます。

概要

このセクションでは、以下のタスクについて説明されました。

• IDAエクスプローラのグラフィカルなビューと表形式のビューを使用してIDAファイルを調
べる。

• 必要性を判断した後、関連するスペクトルを結合する。
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• TIC フィルタと質量不一致・誤差フィルタを使用して、表示されるスペクトルの数を絞り
込む。

• それらを比較できるように、スペクトルを重ね合わせる。

• 基準スペクトルを定義し、表を基に可能性の高い代謝物を発見する。

これらの操作は、IDA データ処理の基本です。

次のセクションでは、ブロモクリプチンの MS/MS スペクトルを用いた構造ツールの使用方法
について説明します。
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ソフトウェアには、イオンの質量を構造体（.mol ファイルとして保存）にリンクし、生物変
換が起こり得るサイトを探索するためのツールが含まれています。

MS/MS スペクトルに構造をリンクさせる

1. ブロモクリプチンの MS/MS スペクトル（652.2211/4.40）の位置を確認します。 IDA Explorer
を使用するを参照してください。

2. 等高線図で Hides all other panes（他のペインをすべて削除する）アイコンをクリック
し、スペクトルのみが表示されるようにします。

3. File > Open Mol Fileをクリックします。

4. Select Mol Fileダイアログで Bromocriptine.molファイルを選択し、 Openをクリック
します。インストールされたデータファイルの場所については、構成を参照してくださ

い。

スペクトルの下に新しいウィンドウが表示され、構造とツールを表示します。
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図 4-1 ブロモクリプチンの構造

5. 構造ペインで Show options dialogをクリックします。 Zoom spectrum (if any) on
selectionとMark selected fragment mass with arrowsの各チェックボックスがオンに
なっていることを確認し、OKをクリックします。他のパラメータを変更する必要はあり
ません。
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図 4-2 [Structure Options ダイアログ

構造ペインを作成したときにスペクトルがアクティブ状態にあったため、スペクトルと構

造は自動的にリンクされます。Displays a spectrum for selectionアイコンを適切なスペ
クトルにドラッグすることで、スペクトルを手動で構造にリンクさせることができます。

構造ペイン内でマウスをドラッグすると、線（投げ縄）がカーソルに追従します。これに

より、構造の全体または一部を選択できます。選択した構造は太字で描画されます。リン

クされたスペクトルがあるため、選択された下部構造の質量の周囲領域を表示するように

ズームやスクロールすることができます。

6. 分子全体を投げ縄で囲みます。そうすると、表示が変わってm/z比652.2177のピークが示
されます。これは（M – H）–イオンに対応します。

Mark selected fragment mass with arrowsチェックボックスがオンになっていたため、
ピークの上下に赤い矢印が描かれます。この矢印は、選択された領域に相応するイオンの

予想質量（データが負の領域にあるため（M – H）-
になる）を示します。

注：構造ペインのタイトルは、選択範囲に相応する元素組成と中性化合物の質量（つま

り、653.2213 Da の質量を持つ C32H40N5O5Br）を示します。

Mark selected fragment mass with arrowsが選択されており、かつ構造ペインで何も選
択されていない場合は、652.2177 のピーク上に緑色の矢印が描画されます。この背景に
は、緑の矢印は現在の選択の補数を表しており、選択されていない状態では補数が全体の

分子となることがあります。

7. 分子全体（臭素原子を除く）を選択します。 図 4-3を参照してください。
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図 4-3 ブロモクリプチンの構造

注：臭素原子のみが通常のフォントで表示され、構造ペインのタイトルが組成C32H40N5O5
と質量574.3029 Daに変わります。スペクトルでは、赤の矢印は選択した構造の予想質量
（すなわち、（M – H）–分子イオンの質量から臭素の質量を除いた質量）を示します。
また、左右に1 Da離れた位置にも矢印が表示されます。フラグメンテーション中は、追
加の水素原子の増減が一般的に発生します。ソフトウェアでは、そうした可能性がある

壊れた各結合に対して、「+1」と「-1」の青い矢印を 2 個一組で描画します。この例で
は壊れた結合が 1 つのみ存在しているため、ちょうど 2 つの矢印が追加されています。

スペクトル内の実際のピークは、これらの矢印のいずれかに対応します。これは、余分な

水素原子（すなわち、HBr）が失われたことを示します。そのため、イオンの質量は（M –
H – HBr）–に対応します。

フラグメントの処理

ソフトウェアは断片イオンの予測機能を含んでおり、この機能では、結合を破壊し水素原子

を追加または除去することにより、種の集団を生成することができます。
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注：この予測は算術のみに基づくものであり、化学的論理は使用されていません。生成さ

れる断片が過大評価される傾向はありますが、断片を分析する上で便利なツールです。

1. 構造ペインがアクティブの状態で、 Show > Fragments Paneをクリックします。

Fragment Optionsダイアログの設定次第では、プログレスバーが表示されます。図 4-4
を参照してください。

2. Show options dialogアイコンをクリックし、図 4-4に従ってパラメータを設定し、 OK
をクリックします。

図 4-4 Fragment Options ダイアログ

一連のシンプルな断片が生成されるようにオプションを設定します。その後、観測された

イオンを説明する必要に応じて、壊れた結合の数と種類を増やします。破壊される結合

数を増やすと、プログラムの動作が遅くなり、意味の無いおそれのあるフラグメントが大

量に生成されます。
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Fragment Optionsダイアログのパラメータの大部分は Reference Guideに説明されてい
ますが、以下の点に注意してください。

• Automatically recalculate on-the-flyチェックボックスにチェックを入れた場合、ス
ペクトルに何らかの変更（別のものへ切り替える、パラメータを調製する、など）を

加えたり、選択を変更したりした場合はフラグメントが再計算されます。これは通常

は望ましい動作ですが、多くのフラグメントを生成するようにオプションを設定した

場合は、分析速度に影響を与える可能性もあります。このオプションを使用しない場

合は、 Fragmentアイコンをクリックします。

• Constrain using peak listでは、適切な公差でスペクトルのピークと一致した断片のみ
ソフトウェアに表示されます。

• Require evidence for previous step when breaking bondのオプションは、複数の結
合が切断されたときにのみ有効です。プログラムでは、最初の結合をまず切断した後

に、生成された断片の結合を破壊するかどうかを決定します。このオプションを選択

した場合、断片をさらに破壊する前に、各断片に相当するイオンが存在している必要

があります。

これらのパラメータを使用した場合、表示画面は図 4-5のようになります。ただし、設定
された（ラベル付けもされた）しきい値を超えるピークのみが考慮されているため、画面

は若干異なる場合があります。
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図 4-5 ブロモクリプチンの構造

注：スペクトルのピークは着色されており、[Fragments] タブに表示されたピークに一致
する、割り当て済み（青色）と未割当（赤色）の各スペクトルが判別できるようになっ

ています。

フラグメントのペインには、2 つのタブがあります。

• Fragments：この例では、リストの長さが短くなっています。その理由は、指定され
た条件下で生成されるフラグメントがそれほど多くないことに加えて、Constrain using
peak listチェックボックスが選択されていることから、その中でもスペクトルでピー
クが一致するものがわずかしかないためです。

• Peaks：スペクトル中のしきい値を超えているピークを一覧表示します。ピークの強度
と、フラグメントに割り当てられているかどうかも示されます。割り当てられたピー

クについては、質量誤差も表示されます。

Explorerチュートリアル
63 / 121RUO-IDV-05-2906-JA-B

構造ツールで作業する



図 4-6 [Fragments] ペイン

3. Fragmentsタブで、m/z比が 324.1929 の行を選択します。ピークは赤い矢印でマークさ
れ、予想質量であることを示しています。相当する下部構造は、構造ペインに太字で描か

れます。
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図 4-7 Fragmentation ダイアログ

注：構造ペインのタイトルに含まれる組成物と質量は、ニュートラルの質量ではなく、

イオンの質量を反映するようになります。

4. 他のフラグメントに割り当てられた構造を調べます。

これらはすべて中央のアミド結合に関連しており、可能性があるように見えます。このア

ミド結合は、分子の 2 つの周期的な部分を分離します。

注：割り当てられた元素組成は、基準スペクトルを使用するで生成されたオーバーレ

イスペクトルと一致しています。そこでは、
79Brおよび 81Brを含む分子イオンのスペクト

ルを比較することによって、断片中のBrの存在が推定されています。

5. 全質量範囲が表示されるように、スペクトルを拡大します。

分子の両側に対応する2つの主要ピーク（324.1970のm/zと344.0430のm/z）が割り当てら
れており、青で描画されています。ただし、多くのピークがまだ割り当てられていませ

ん。
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6. Optionsのダイアログを開き、Maximum number of bonds to breakを 2に変更しま
す。

注：しきい値設定によっては、このオプションを変更することでいくつかの小さなピー

クが割り当てられることもありますが、より大きなピーク（たとえば、m/z比が114.0584、
209.1337、227.1431のものなど）は割り当てられません。スペクトルが赤の矢印に対して
ラベル付けされている場合は、構造ペインをクリックすることで、すべての選択を消去

し、絶対質量値を表示することができます。

7. Break ring bondsチェックボックスをオンにし、 OKをクリックします。

これにより、多くの付加的なイオンが一致します（m/z比が209.1337および227.1431のも
のを含む）。 Fragmentsペインで新しい質量を選択して下部構造を強調表示すると、そ
れらが分子の環状ペプチド部分にある環開裂に関連していることがわかります。これらの

イオンは、この領域における代謝変換部位を決定するのに有用となることが予想されま

す。

スペクトルに下部構造を追加する

構造の一部を選択し、それらを使用してスペクトルに参考用の注釈を付けることができます。

スペクトルペインの大きさ次第では、構造ペインの Optionsダイアログから、コピー時の
Target Bond Lengthを調整します。

1. Fragment Optionsダイアログの中でBreak ring bondsのチェックボックスを外し、フラ
グメント数を減らします。

2. フラグメントペインで、より豊富なイオンの 1 つに対応する行を選択し、対応する下部構
造を強調させます。

3. 構造ペイン内をクリックします。

4. Edit > Copyをクリックします。

5. アクティブなスペクトルペイン内を右クリックし、 Paste Imageをクリックします。

これにより、下部構造の画像がスペクトルペインにペーストされます。

6. 画像を移動させるには、目的の場所までドラッグします。画像を完全に削除するには、
画像を右クリックし、 Delete Imageを選択します。

画像はスペクトル（つまり、質量強度位置）にリンクされているため、スクロールやズー

ムによって動かすことができます。

7. 他のフラグメントイオンについても、ステップ 2 ～ 6 を繰り返し、図 4-8に似た最終画像
を生成します。
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図 4-8 追加下部構造を持つスペクトル

8. File > Print > Print Preview Windowをクリックし、下部構造の位置を確認します。

一致したイオンは青色で描かれているため、対応する構造に簡単に関連付けできます。

9. 線などを追加するには、画像をコピーして描画プログラムに貼り付けます。

関連 MS/MS スペクトルで作業する
いくつかの用途では、変更された化合物（代謝産物など）のスペクトルを、プレカーサー化

合物のスペクトルや構造と比較できると便利です。

1. 再び等高線図を表示するには、IDA Explorer を使用します。 668.2176 / 4.21 のピークを選択
し、等高線図を非表示にします。

構造ペインとフラグメントペインはスペクトルにリンクされているため、新しいスペク

トルを反映するよう更新されています。ただし、構造体は依然としてプレカーサー化合物

からのものであり、スペクトルは追加の酸素原子を有する化合物（質量は 16 Da 高い）か
ら取得されています。多くの場合、一致するケースは依然として残っており、変化して

いない分子の部分を示します。ただし、この例では、重要なイオンはすべて一致しておら

ず、それらは赤で描画されています。

構造ペインには、くつかの簡単な描画ツールが含まれています。これらを使用すると、構

造を変更し、一致を探すことができます。

2. 構造ペインの左側には、要素記号と共にグリッドが表示されます。 Oをクリックし、中
心構造体に向けてドラッグします。
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原子が構造体に近い場合は、結合により接合されています。この結合は、構造体の近くで

マウスをドラッグすると、カーソルの後を追いかけます。

3. 結合が構造（エルゴリン）の下部に描画されるように Oシンボルをドラッグしてから、
マウスのボタンを離します（たとえば、新しい原子をフェニル環上に配置します）。図

4-9には、プロセスを示しています。

図 4-9 構造ペイン

スペクトルが再び更新され、2つの一致が見つかったことを示します。1つは668.2089の分
子イオンで、もう1つはHBrの損失に対応する588.2828のイオンです。これは、全体的な元
素組成は正しくなったことを示唆しています。ただし、主要なフラグメントが一致しない

という事実は、原子が分子の適切な部分に追加されなかったことを示唆しています。

4. ここで追加した OH基をクリックし、構造体の上部にあるピロリジン環にドラッグしま
す。移動中の原子のみが太字で描かれていることを確認します。そうでない場合は、強

調表示された下部構造全体を移動させます。

図 4-10に示すように、これにより 340.1927、366.1722、および 367.1797 でイオンが整合さ
れます。対応する下部構造は、プレカーサー化合物のスペクトルに一致する、ヒドロキシ

ル化されたイオンであることが判明します。

チュートリアルExplorer
RUO-IDV-05-2906-JA-B68 / 121

構造ツールで作業する



図 4-10 ブロモクリプチンからのスペクトル

整合できない低質量ピークの多くは、プレカーサーのスペクトルに存在していたか、また

はアルゴリズムによる共有結合の破壊を許可した際に整合されたヒドロキシル当量となり

ます。ただし、637.1725 に高質量イオンがあり、これはフラグメンテーションのステップ
の簡素さに起因する可能性が高く、まだ整合もされていません。

5. Fragmentsタブでは、668.2089 の行を選択します。これにより、この行がラベル付けさ
れ、他のイオンはそれを基準にラベル付けされます。

これにより、637.1725のピークはプレカーサー分子（CH3NH2またはCH3Oの可能性がある）
からの31.0364の損失に対応することがわかります。このイオンはプレカーサー分子のスペ
クトルで観察されていなかったため、構造の環状ペプチド部分にあるメチル基のいずれか

で発生した水酸化に由来している可能性が最も高いと思われます。

6. 構造ペイン内を 2 度クリックして構造の選択を解除し、新しいOH基を、構造の右側にあ
るいずれかのメチル基までドラッグします。

7. Fragment Optionsダイアログを開き、Mass toleranceを 30 ppm に設定し、OKをクリッ
クします。

これにより、637 イオンが整合されます。フラグメントペインからこの行を選択すると、
イオンはメトキシ部分の損失に相当する可能性があることが表示されます。
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8. [Fragment Options]ダイアログを開き、 [Break ring bonds]のチェックボックスを入れ、
[OK]をクリックします。

これにより、フラグメントの大部分は整合されます。ただし、209 のイオンは、3 個の結
合（2 個はプレカーサー分子に必要で、1 個は追加の酸素原子の損失のために必要）を破
壊することが許可されている場合にのみ整合できます。

注： [Fragments]ペインで、一部の質量（637.1905など）について複数の行が表示されま
す。各行は、一致する可能性がある別々のフラグメントに対応しています（3個の結合を
破壊することを許可した場合はさらにフラグメントの数が増えます）。[Fragments]ペイン
の[Peak]タブには、質量精度、破壊結合の数、フラグメントがラジカルかどうかなどの組
み合わせに基づいて、最もよく一致していると判断されたものだけが表示されます。こ

の例では、整合する可能性が最も高い組み合わせは、プレカーサー化合物から生成され

る可能性もあった（実際には観察されなかった）断片に相応しています。そのため、

[Fragments] タブに表示される追加オプションには、一見判別しにくい整合可能性が表示
されるため役立ちます。

概要

このセクションでは、以下のタスクについて説明されました。

• 構造を .mol ファイルにより入力した後、スペクトルにリンクする。

• 構造の一部を選択し、それに対応する質量ピークがあるかどうかを判断する。

• 断片ペインを生成し、シンプルな断片を観察するためのパラメータを設定する。

• FragmentsおよびPeaksの各タブを操作し、一致する組成物、下部構造、および質量ピー
クを表示する。

• Fragment Optionsでは、設定を変更することで、より複雑なフラグメンテーション経路
を可能にする。

• スペクトルペインに下部構造を追加する。

• 構造を変更し、代謝産物のような関連分子のフラグメンテーションを検討する。

一般的には、シンプルな断片化プロセスから開始し、観測されたイオンを説明する必要があ

る場合は追加のフラグメンテーションのオプション（結合の追加、共有結合）を使用するこ

とをお勧めします。これは、断片化イオンは一般的に一連のステップで断片化するという事

実に一致します。複数の結合を一度のステップで集中して破壊するのではなく、シンプルな

フラグメントが最初に形成されます。もちろん、シンプルなフラグメントは不安定になり直

後に細分化することもあるため、それを観察できない場合もあります。また、多くのフラグ

メンテーションのステップを実行すると処理時間もそれに比して長くなり、完了までに時間

がかかります。

関連分子を比較する際は、基準スペクトル（プレカーサー分子）に変更形態を重ね合わせた

後、構造ペインまたはフラグメントペインにビューをリンクさせると便利です。ビューは、
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アクティブスペクトルを切り替える際に更新されます。ただし、オーバーレイの表示では、

色分け次第では一致したイオンとそうでないイオンを区別するのが難しい場合もあります。

そのため、ソフトウェアやビューの操作に慣れるまでは、単一のスペクトルで作業すること

をお勧めします。
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分析を進める際は単一のサンプルを使用するのが一般的ですが、複数のサンプルを比較する

か可視化することで追加の情報が得られる場合もあります。このセクションでは、2 つのサ
ンプルについてソフトウェアで利用可能なツールの一部について説明し、その後は複数のサ

ンプルの場合についても取りあげます。

2 つのサンプルを分析する
一般的なワークフローでは、異なる条件で得られた 2 つのサンプルを比較し、変更を特定し
ます。例えば、医薬品の投与後には、2 つの異なる時点からのサンプルを比較します。この
例（T = 0 時間、T = 1 時間）で比較するデータは、血漿に調製したラットの肝臓ミクロソーム
を用いたブロモクリプチンのインキュベーションからのものです。

開始する前に、開いているウィンドウをすべて閉じます。

1. File > Open Multiple Samplesをクリックし、サンプルデータを含むフォルダを参照しま
す。

2. Bromocrip_IDA-DBS in plasma_T=0.wiffおよびBromocrip_IDA-DBS in plasma_T=1.wiff
の各ファイルを選択し、ファイルをウィンドウの右側にドラッグします。

3. OKをクリックします。
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図 5-1 複数のサンプルを選択する

単一の IDA ファイルを開くと、調査スキャンとディペンデントスキャンが別々の TIC とし
て表示されます。それとは対照的に、複数の IDA ファイルを使用すると、すべてのサンプ
ルについて全データが単一の TIC に表示されます。この場合、図 5-2に示すように、2 つ
のTIC が存在します。
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図 5-2 TIC

4. Show > Total Ion Chromatogram (TIC)をクリックし、 Select Experimentダイアログを
開きます。

5. Period 1, Experiment 1 - TOF MS (100 - 2000)を選択し、 OKをクリックします。

図 5-3 [Process All Overlays] ダイアログ

重ねトレースが処理されるたびに表示される Process All Overlaysダイアログでは、すべ
てのトレースを処理するか、またはアクティブのトレースのみを処理するかを選択できま
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す。以降の操作はすべてのトレース（サンプル）に影響を与えるため、すべてのトレー

スを処理すると便利です。

6. All Overlaidを選択します。

7. Only show the dialog again if the shift key is downを選択し、この選択をデフォルト
のアクションに設定します。

8. OKをクリックします。

調査TICのオーバーレイを含むペインが生成されます。このクロマトグラフィーは非常に再
現性が高く、代謝物のピークが強いため、いくつかはクロマトグラムの拡大表示や比較に

よって見つけることができます（6分前後の領域を調べてください）。ただし、通常は追
加の作業が必要になります。より容易に比較できるビューを生成するには、いくつかの方

法があります。この例では、ベースピーククロマトグラムを使用します。

注： File > Open Heat Map TICs from Wiffをクリックすると、最初に重ねクロマトグ
ラムを表示することなく、ストリップビューを直接生成することができます。

9. 最初の TIC ペインを非表示にし、Show > Base Peak Chromatogram(BPC)をクリックし
ます。

10. BPC Optionsダイアログの中で、必要に応じて図 5-4の値と一致するように設定を変更
し、 OKをクリックします。

図 5-4 [BPC Options] ダイアログ
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ベースピーククロマトグラムは、各スキャンにおける最大ピークの強度を保持時間の関数

としてプロットすることで構築されます。追加情報を提供するため、このダイアログで

指定した質量許容範囲を超えてベースピーク質量が変化した場合に、各トレーススイッ

チは通常色と灰色の間で切り替えを行います。

必要に応じて、対象となる質量範囲を制限することができます。これにより、ノイズの多

いバックグラウンドピークに起因するアーチファクトを回避し、保持時間範囲を設定し

て処理を高速化することができます。ブロモクリプチンの質量は約 652 であることが判明
しているため、単純な代謝物は 500 のm/z比を超えることはありません。

11. Process All Overlaysダイアログで All Overlaidオプションが選択されていることを確認
し、 OKをクリックします。

新しいペインに BPC が表示されます。これは、元の TIC と比べ、はるかに簡単かつ手軽に
比較することができます。

図 5-5 BPC

T = 0 のサンプル（青）と比較して、1 時間のサンプル（ピンク）で減少したように見える
ピーク（赤い矢印）が 2 つ存在しています。これらは、ブロモクリプチン（6.09 分）お
よび異性体に相応します。また、T = 1 のサンプルには存在する一方で、T = 0 のサンプル
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には存在しなピーク（青の矢印）も 3 つ存在しています。これらは潜在的な代謝産物で
す。

注： BPC は非常に便利な場面もありますが、（選択した質量範囲で）最も強いイオンの
挙動のみが反映されます。ベースピークにならない質量ピークは絶対に表示されないた

め、サンプル間の違いを特定する際は他のツールを使用する必要があります。

12. TIC ペインを非表示にします。

13. BPC ペインで 6.09 分の部分をダブルクリックします。

14. Process All Overlaysダイアログ内の All Overlaidを選択し、 OKをクリックします。

これにより、2 つの重ねスペクトルが生成されます。

15.スペクトルペイン内をクリックして拡大表示し、652 のm/z比の周辺にあるアイソトープ
クラスタを表示させます。図 5-6を参照してください。

スペクトルペインに2つのサンプルのスペクトルが重ね合わせて表示されるため、両者を
簡単に比較できます。この例では、T = 1時間のサンプル（ピンク）における強度は、T =
0時間のサンプルよりも明らかに小さくなっています。

このような分解能の高いデータを表示する場合、概要グラフは非常に有用です。この方法

では、スペクトル全体を表示しつつ、詳細を確認することができます。
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図 5-6 652 の m/z比付近のアイソトープクラスター

16. [Chromatogram]ペインで、スペクトルの時間を示す行にカーソルを移動します（以前はダ
ブルクリック）。

17.カーソルが両端矢印に変わったら、約 5.8 分のピークにドラッグします。

スペクトルは、拡大表示質量範囲を引き続き示します。この範囲では、ノイズと小さな

ピークのみが含まれています。メインウィンドウに大きなピンクのピークを表示するに

は、以下の黒い矢印で示した概要グラフでピンクの長方形をドラッグします。マウスを

離すと、ビューは再び初期値に戻ります。

図 5-8では、 Label all overlaid traces（すべての重ねトレースにラベルを表示する）ア
イコンが選択されていました。
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図 5-7 BPC とスペクトル
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図 5-8 [Label all overlaid traces] のオプションを適用した BPC とスペクトル

これらのピークは、T = 0 のサンプルには存在しません。

18.続行する前に、開いているウィンドウをすべて閉じます。

複数のサンプルを処理する

2 つ以上のサンプルを重ね合わせた場合、ウィンドウが煩雑になり、差異を基に正しいサン
プルと結合する作業が困難になることもあります。ソフトウェアには他のツールも含まれて

おり、それらは多くのサンプルからのデータを表示する際に役立ちます。

この例で使用するデータセットは、6 つの異なるデータセットに対する不純物プロファイル
分析を基にしています。

1. File > Open Multiple Samplesをクリックします。

2. DataSet61.wiff ～ DataSet66.wiffまでの各ファイルを選択し、 Selectedパネルに移動
させます。
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図 5-9 複数のサンプルを選択した状態

3. OKをクリックします。

4. Show > Total Ion Chromatogram (TIC)をクリックします。

5. Select Experimentダイアログから、 Period 1, Experiment 1を選択します。
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図 5-10 実験サンプルダイアログの選択

6. OKをクリックします。

7. Process All Overlaysダイアログで All Overlaidを選択しOKをクリックします。グラフ
は、ファイル内の各サンプルについて、TIC クロマトグラムのオーバーレイを示します。
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図 5-11 DataSet61.wiff から DataSet66.wiff までの実験 1 に基づく、重ね合わせた TIC

アクティブトレースのタイトルは太字で表示されます。このタイトルの左にあるアイコ

ンをクリックすると、ヘッダを単一の行に折りたたみます。これにより、情報の表示領域

を増やすことができます。

8. Show > Overlaid Traces as Heat Mapをクリックします。表示されたペインでは、色の
管理メニューから、min %が 0.5に、およびmax %が 100になるように設定します。

ヒント！色の管理メニューが表示されていない場合は、右クリックから Show
Appearance Controlを選択します。

9. クロマトグラムペインの内側をクリックし、 Hides all other panes（他のペインをすべ
て削除する）アイコンをクリックします。
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図 5-12 ヒートマップクロマトグラム

各サンプルは、単一の水平ストリップで表されます。これは、強度に応じて色分けされた

TICを示します。上記のカラースキームを使用した場合、黄色は、データが取得されなかっ
た点か、または全サンプル中の最大値に対して強度が 0.5 % 未満の場所を表します。青色
は0.5％を、および赤色は最も強い信号を表します。

ウィンドウには6～7個のピーク（4.5分から6.5分の間）が表示され、その反応は6.5分のピー
クを除いて異なります。

ピークの順序は、サンプルが取得された順序と同じです。そのため、これらは理想的では

ない場合もあります。この例では、順序に問題はありません。

10.ペイン内で右クリックし、 Show Samples Tableをクリックします。最初は、サンプル
表がヒートマップの右側に表示されます。 ペインの右上にある Drag and drop to
rearrange the panes（ドラッグアンドドロップ操作でペインの位置を変える）アイコン
は、 ペインをヒートマップの最後に をドラッグし、表を元のペインの下まで移動させる

ときに使用します。
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図 5-13 ヒートマップクロマトグラムのサンプル一覧

表には、各サンプルに関連する様々なテキストフィールドの列が含まれています。Display
Nameの列は編集可能ですが、他の列は読み取り専用です。すべての列は、表およびビュー
のサンプルを分類するために使用することができます。

11. Imp STD 10の5.5分の部分を囲むように選択し、その内側でダブルクリックします。

新しいヒートマップスペクトルのペインが生成され、完全な質量範囲が X 軸上に示され
ています。
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図 5-14 ヒートマップスペクトル

このスペクトルから、選択した時間領域において、いくつかの質量（400のm/zから460の
m/zの間）が強度増加の一因になっていることがわかります。

12. Imp STD 10 サンプルについて質量/電荷 Da 401 周辺の部分を選択し、右クリックして Show
Spectra for Selected Samplesを選択します。

これにより、選択したサンプルについてスペクトルが生成されます。その時点における

スペクトルが表示されます。 図 5-15を参照してください。

13.ヒートマップスペクトル内で質量/電荷 Da 401 周辺の質量をダブルクリックし、ヒート
マップ XIC を生成します。
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図 5-15 スペクトル

概要

このセクションでは、以下のタスクについて説明されました。

• ソフトウェアで利用可能な、複数のサンプルツールを使って作業する。

• 重ねクロマトグラムと、インタラクティブなスペクトルを持つ 2 つのサンプルを比較す
る。

• ヒートマップビューを用いて、複数のサンプルを比較する。
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このセクションでは、ソフトウェアの Bio Tool Kitメニュー項目から利用できるオプション
の一部を説明します。

注：この機能にアクセスするには、バイオツールキット MicroApp 機能を有効にする必要
があります。アクティベーションが完了するまでは、利用できるオプションが [Peptide
Fragments（ペプチド断片）]、[Add Manual Reconstruct Highlights（手動再構築マーカの追加）]、
および [Remove Manual Reconstruct Highlights（手動再構築マーカの削除）] に限られます。リ
リースノート文書の「Activate the Bio Tool Kit MicroApp Feature（バイオツールキットの MicroApp
機能を有効化する）」を参照してください。

手動配列

消化タンパク質サンプルからの MS/MS スペクトルデータを手動配列する場合は、このオプ
ションを使用します。

1. メインツールバーから、 Open Sampleのアイコンをクリックします。

Select Sampleダイアログが開きます。

2. Sample Dataフォルダがすでに選択されていない場合は、BrowseをクリックしてSample
Dataフォルダに移動します。

3. RP_digests.wiffファイルを選択し、 OKをクリックします。

Open IDA Sampleダイアログが開きます。

図 6-1 IDA サンプルダイアログを開く
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4. With the IDA Explorerオプションが選択されていることを確認し、 OKをクリックしま
す。

図 6-2 RP_digests.wiff からのスペクトル

5. Tableタブをクリックします。

6. m/z 471.2398を Time 12.73で選択します。

7. 構造ペインがアクティブの状態で、 Graph > Duplicate Graphをクリックします。

選択されたプレカーサー（471.2）について、新しい [Spectrum] ペインが開きます。 [IDA
Explorer] ペインと、それに関連する [Spectrum] ペインは削除して構いません。
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図 6-3 保持時間（12.73）におけるプレカーサー（471.2398）のスペクトル

8. ラベルが 738.3833のピークを選択します。

9. Bio Tool Kit > Manual Sequenceをクリックします。

Sequence Optionsダイアログが開きます。
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図 6-4 [Sequence Options] ダイアログ

注： [Ignore isotopes and check charge state] のチェックボックスが選択されている場合、ソ
フトウェアで後続のアミノ酸を提案した際に、アイソトープおよび誤った電荷状態にあ

るピークはすべて無視されます。

10. OKをクリックします。

Create Sequenceのダイアログが開きます。

Explorerチュートリアル
91 / 121RUO-IDV-05-2906-JA-B

バイオツールキットの機能を使用する



図 6-5 [Create Sequence] ダイアログ

注：このダイアログでは、ファイルに対して手動配列を行った後、Y 系列と B 系列のイ
オンと電荷状態に関する仮定を変更し、データに対して最も整合性の高い仮定を選ぶこ

とができます。

11. Create Sequence (for Peptide Fragments Pane)のチェックボックスが選択されているこ
とを確認します。

12. Precursor chargeフィールドに 2と入力します。

13.手動配列ツリーに従って、 Fragment chargeフィールドに、選択されたピークの電荷値
を入力します。

14. OKをクリックします。

ソフトウェアが更新され、更新された[Spectrum] ペインが表示されます。この中では、ス
ペクトルデータ上で追加ないし喪失した（関連性があると考えられる）アミノ酸の最初

の 1 組が、赤の縦線で表示されます。
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図 6-6 手動配列のスペクトル：当初の可能性

15.さらに配列決定する部分について、赤い縦線のキャプションをダブルクリックします。

ソフトウェアが更新され、スペクトルデータにおけるアミノ酸の次の 1 組が表示されま
す。

16.関連性があると考えられるアミノ酸がすべて提示されるまで、ステップ 15 を繰り返しま
す。
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図 6-7 手動配列スペクトル

注： 図 6-7では 、キャプションをクリックした順序は F > G > I/L > E > Yです。

ヒント！ソフトウェアに複数の可能性が提示されている場合で、かつ最初に提案された

ものとは異なる分岐に従う場合は、グラフを初期表示に戻し、この手順（別の相応アミ

ノ酸のラベルを選択する）を繰り返します。

ペプチドフラグメントと連動させた手動配列決定

1. Bio Tool Kit > Peptide Fragmentsをクリックします。

[ペプチドフラグメント] のペインが開きます。このペインは、手動で配列決定されたスペ
クトルにリンクされています。
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図 6-8 手動で配列決定されたスペクトルにリンクされた [Peptide Fragments] のペイン

注：実験データと一致しているアミノ酸は、[Table] タブの列に赤色の太字で表示されま
す。実験データと一致しており、かつ異なる対象フラグメントの電荷を持つアミノ酸

は、[Table] タブの列に赤色の斜体で表示されます。

2. Listタブをクリックします。

3. Show > Mass Calculatorsをクリックします。

4. AA Propertyタブをクリックします。
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図 6-9 質量電卓：[AA Property] タブ

注：デフォルトでは、質量電卓は、手動で配列決定されたスペクトルに自動的にリンク

されます。スペクトルからのアミノ酸配列は、 AA sequenceフィールドに表示されま
す。

5. スペクトルペインがアクティブな状態で、 Bio Tool Kit > Set Sequence Creation
Parametersをクリックします。

Create Sequenceのダイアログが開きます。
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図 6-10 Create Sequence ダイアログ

6. Create Sequenceダイアログを以下のように入力します。

• Create Sequence (for Peptide Fragments Pane)のチェックボックスが選択されてい
ることを確認します。

• Assume b-seriesオプションを選択します。

• Precursor m/zフィールドに 471.2398と入力します。

• Precursor chargeフィールドに 2と入力します。

• Fragment chargeフィールドに 1と入力します。

7. OKをクリックします。

[Peptide Fragments] と [Mass Calculators] の各ペインに、更新後の配列データが反映されます。

8. Peptide Fragmentsペイン内の Tableタブをクリックします。
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図 6-11 手動で配列決定されたスペクトルにリンクされた [Peptide Fragments] のペイン
（更新後）

9. スペクトルペインがアクティブな状態で、Bio Tool Kit > Clear Manual Sequencingをク
リックします。

手動配列のマーキングがすべて消去されます。

手動再構築ハイライトの追加と削除

Add Manual Reconstruct Highlightsオプションを使用して、特定の質量の理論的なm/z位
置をスペクトルに示すマーカーを追加することができます。この機能は、スペクトルに多価

成分が含まれているときにスペクトルの特定のピークが同じ成分に対応するかどうかを確認

するのに便利です。マーカーを削除するには、 Remove Manual Reconstruct Highlightsオ
プションを使用します。

ヒント！マーカを別の位置に移動するには、マーカーの垂直線を新しいm/z値にドラッグ
します。

ヒント！マーカをアクティブにするには、マーカーの垂直線をクリックするか、対応する

荷電状態ラベルをクリックします。アクティブなマーカーにはm/z位置が表示されます。

1. メインツールバーから、 Open Sampleのアイコンをクリックします。

Select Sampleダイアログが開きます。
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2. Sample Dataフォルダがすでに選択されていない場合は、BrowseをクリックしてSample
Dataフォルダに移動します。

3. RP_Intact.wiffファイルを選択し、 OKをクリックします。

図 6-12 RP_Intact.wiff ファイルからの TIC

4. ミオグロビンについて、ピークの上部領域（5.91 分～ 6.00 分）を用いて平均スペクトル
を作成します。
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図 6-13 平均化スペクトル

5. スペクトルペインがアクティブな状態で、 Bio Tool Kit > Add Manual Reconstruct
Highlightsをクリックします。

Add Manual Reconstruct Highlights to Graphダイアログが開きます。
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図 6-14 手動再構築ハイライトをグラフへ追加する

6. Valueフィールドに 16950と入力します。

7. Charge agentに H+を選択し、 OKをクリックします。

ハイライトを含むグラフが更新されます。

図 6-15 追加されたハイライトを含むスペクトル

8. マーカーを削除するには、 Bio Tool Kit > Remove Manual Reconstruct Highlightsをク
リックします。

グラフが更新され、ハイライトが削除されます。
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消化プロテイン

理論的なペプチド配列の情報を取得するには、このオプションを使用します。この情報は、

指定したタンパク質の、ユーザが定義した酵素的切断から生じます。

ツールバー

ツールバーのアイコンを使用することで、必要に応じて視野を調整することができます。

表 6-1 ツールバーアイコン

名称（ツールヒント）アイコン

配列内の検索と置換

選択した文字を大文字に変換する

配列の検索

注： [Deletes this pane] のアイコンで始まる、ツールバーの最後尾にあるアイコン 6 個につい
ては、汎用ペインのツールバーに記載されています。

配列内の検索と置換

このオプションでは、Sequenceフィールドに入力されたテキストを検索し、新しいテキス
トに置き換えることができます。

1. Find and replace in sequence（配列内を検索して置換する）アイコンをクリックしま
す。

Find and Replace Textダイアログが開きます。

図 6-16 [Find and Replace Text] ダイアログ

2. Findフィールドに置き換えられることになる情報を入力します。
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3. Replaceフィールドに、必要な情報を入力します。

4. OKをクリックします。

ソフトウェアは、ユーザが指定した既存のテキストを置換テキストに置き換えます。

選択された文字を大文字に変換する

このオプションでは、 Sequenceフィールドに入力したテキストを変換（大文字 > 小文字）
することができます。

1. 必要な文字を選択します。

2. Convert selection to uppercase（選択された文字を大文字に変換する）アイコンをク
リックします。

ソフトウェアは、テキスト内の小文字を大文字に置き換えます。

配列の検索

このオプションでは、 Sequenceフィールド内のテキストを検索できます。

1. Find sequence（配列を検索）アイコンをクリックします。

Find Textダイアログが開きます。

図 6-17 Find Text ダイアログ

2. Findフィールドに必要な情報を入力します。

3. OKをクリックします。

一致するテキストは、ソフトウェアによって強調表示されます。

理論的タンパク質消化

1. Bio Tool Kit > Digest Proteinをクリックします。

Proteinペインが表示されます。
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図 6-18 Protein ペイン： Protein & Peptides タブ

2. 表示されたフィールドに、タンパク質またはペプチド配列を入力します。

注：このチュートリアルでは、GLSDGEWQQV LNVWGKVEAD IAGHGQEVLI RLFTGHPETL
EKFDKFKHLK TEAEMKASED LKKHGTVVLT ALGGILKKKG HHEAELKPLA QSHATKHKIP IKYLEFISDA IIHVLHSKHP
GDFGADAQGA MTKALELFRN DIAAKYKELG FQG（ミオグロビンの配列）を使用しました。

3. Enzyme（酵素）を選択します。

注：このチュートリアルでは、トリプシンを選択しました。

4. Max. missed cleavagesを選択します。

注：このチュートリアルでは、0 を選択しました。

5. Digestをクリックします。

ソフトウェアは、消化されたペプチドとその配列の理論的な情報を表に入力します。
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図 6-19 理論的情報が入力された Protein ペイン

6. Variable Modificationsタブをクリックします。
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図 6-20 Protein ペイン： Variable Modifications タブ

7. Max. number of simultaneous modifications を選択します。

注：このチュートリアルでは、3 を選択しました。

8. 適切な変更を反映させるには、 Use列のチェックボックスを入れます。

ヒント！チェックボックスの左側にアイコンが表示されている場合は、アミノ酸のリス

ト全体を選択するか、または必要なものだけを選択することができます。

注：このチュートリアルでは、[1AC] のチェックボックスを選択しました。
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図 6-21 変更の選択例

9. Protein & Peptidesタブをクリックします。

10. Digestをクリックします。

表の表示が変更され、ユーザによる選択内容が反映されます。
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図 6-22 変更後の情報が入力された Protein ペイン

LCMS ペプチド再構築
LCMS ペプチド再構築では、スペクトルのピークを識別し、識別されたスペクトルピークから
デコンボリューションを行います。 LCMS ペプチド再構築ツールでは、2 つのステップが実行
されます。まず、ピークは「強化」ピーク発見アルゴリズムにより発見されます。次に、ア

イソトープ系と電荷系を構成する一群のピークを検索し、発見されたコンポーネントすべて

の中性質量を表示します。

1. メインツールバーから、 Open Sampleのアイコンをクリックします。

Select Sampleダイアログが開きます。

2. [Sample Data] フォルダがすでに選択されていない場合は、BrowseをクリックしてSample
Dataフォルダに移動します。

3. RP_digests.wiffファイルを選択し、 OKをクリックします。

Open IDA Sampleダイアログが開きます。
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図 6-23 IDA サンプルダイアログを開く

4. 標準TICとしてオプションが選択されていることを確認し、 OKをクリックします。

最初のトレースとして「IDA Survey from RP_digests.wiff (sample 1) - Sample001」が
太字で表示されていることを確認します。必要に応じて、このトレースを選択します。

図 6-24 RP_digests.wiff を基にした IDA 調査

5. Bio Tool Kit > LCMS Peptide Reconstruct (with peak finding)をクリックします。

LCMS Peptide Reconstruct Optionsダイアログが開きます。
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図 6-25 LCMS Peptide Reconstruct Options ダイアログ

6. 表示されたフィールドに次の値を入力します。

• Minimum retention time（最小保持時間）フィールド：9.00分

• Maximum retention time（最大保持時間）チェックボックスをオンにし、フィール
ドに 16.00と入力

• Approximate LC peak width (おおよその LC ピーク幅）フィールド：6.0秒

注：バックグラウンド減算の間は、およそのピーク幅を基にオフセットが決定され

ます。

• Minimum intensity in counts（最小強度（カウント））フィールド：5

• Chemical noise intensity multiplier（化学ノイズ強度乗数）フィールド：1.5

• Mass tolerance（質量公差）フィールド：0.100 Da

• Maximum charge（最大電荷）フィールド：5

注： [Charge Deconvolution（電荷デコンボリューション）] セクションの質量許容差では、
理論的に消化されたタンパク質と再構成されたピークが一致していることを確認し、同

じペプチドに属するm/z各値を一緒にグループ化します。

7. OKをクリックします。

ソフトウェアは、保持時間ごとのペプチドを表に示します。表示されたペプチドについ

ては、それぞれ次の情報が提供されます。Index（指数）、 Ret. Time（保持時間）、
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Mass（質量）、Mass / Charge（質量/電荷）、 Int. Sum（初期合計）、および Num.
Peaks（ピーク数）。

図 6-26 再構成されたピークの一覧

8. Filteringを展開し、使用可能なフィルタを表示します。

利用可能なフィルタリングオプションは、次のとおりです。 Intensity threshold（強度
閾値）、Min. Num. Peaks （最小ピーク数）、および Show matched peaks only（一致
したピークのみ表示する）。
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図 6-27 フィルタリングオプション

9. 表示内容を調製する必要がある場合は、1 つ以上のフィルタを選択します。

注：このチュートリアルでは、強度閾値は 2.39e4 に、および最小ピーク数は 4 に設定
されていました。

図 6-28 再構成されたピークの一覧（フィルタ適用後）
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ツールバー

ツールバーのアイコンを使用することで、必要に応じて視野を調整することができます。

表 6-2 ツールバーアイコン

名称（ツールヒント）アイコン

スペクトルと XIC を表示

IDA MS/MS スペクトルを表示

注： [Deletes this pane] のアイコンで始まる、ツールバーの最後尾にあるアイコン 6 個につい
ては、汎用ペインのツールバーに記載されています。

スペクトルと XIC を表示

Show spectrum and XIC（スペクトルと XIC を表示）アイコンが選択されている場合、以下
のスペクトルペインと XIC ペインが開きます。

図 6-29 スペクトルと XIC の各結果を表示

生成された MS スペクトルについては、ペプチドの質量決定の一因となった各ピークの下に
矢印が表示されます。ペプチドの質量決定の一因となった各m/zピークの XIC は、右側のペ
インにオーバーレイとして表示されます。
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IDA MS/MS スペクトルを表示

Show IDA MS/MS Spectra（IDA MS/MSを表示）アイコンが選択されている場合、以下の
スペクトルペインが開きます。

消化タンパク質と LCMS ペプチド再構築

1. Bio Tool Kit > Digest Proteinをクリックします。

Proteinペインが表示されます。

2. Proteinペインの Drag to a protein pane to set its peak list（[タンパク質]ペインにド
ラッグしてピークリストを設定する）アイコンを、Reconstructed Peak Listペインにド
ラッグします。

Proteinペインが更新され、[Reconstructed Peak List（再構成されたピークリスト）] のもの
と一致するペプチド配列が表示されます。 Proteinペインに赤い太字で表示されるフラグ
メントは、 Reconstructed Peak Listのペインにあるものと正確に一致しています。赤い
通常のフォントで表示されるフラグメントは、 Reconstructed Peak ListペインのMatch
列で括弧内に示された荷電状態が割り当てられていた場合に、 Reconstructed Peak List
ペインにあるものと一致したと考えられるフラグメントを指します。黒のフォントで示

したフラグメントは、 Reconstructed Peak Listペインのフラグメントといずれも一致し
ないものを指します。
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図 6-30 [Reconstructed Peak List] にリンクされた、[Protein] ペイン上の理論上の情報

タンパク質の再構築

蛋白質タンパク質の平均質量（分子量）を取得する場合は、このオプションを使用します。

1. メインツールバーから、 Open Sampleのアイコンをクリックします。

Select Sampleダイアログが開きます。

2. Sample Dataフォルダがすでに選択されていない場合は、BrowseをクリックしてSample
Dataフォルダに移動します。
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3. RP_Intact.wiffファイルを選択し、 OKをクリックします。

図 6-31 RP_Intact.wiff ファイルからの TIC

4. 5.93 分のピーク領域を基に平均スペクトルを作成します。図 6-32を参照してください。
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図 6-32 平均化スペクトル

5. スペクトルペインがアクティブな状態で、 Bio Tool Kit > Reconstruct Proteinをクリッ
クします。

Reconstruction Optionsダイアログが開きます。

図 6-33 再構築オプション
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6. 次の各オプションに、適切な値を入力します。

• Start mass（開始質量）：15000 Da

• Stop mass（停止質量）：18000 Da

• Step mass（質量間隔）：1.0 Da

7. 適切な入力スペクトル アイソトープ分解能（中等度：10000）を選択します。

注：四重極システムを用いて取得されたデータについては、入力スペクトル アイソトー

プ分解能パラメータの代わりに、ピーク幅パラメータが表示されます。

8. 適切な電荷剤（H+）を選択します。

9. OKをクリックします。

ソフトウェアは、再構築されたタンパク質のスペクトルを生成し、「再構築、入力スペ

クトルのアイソトープ分解能 [ユーザーが選択]」のタイトルが付いた別のペインに表示し
ます。
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図 6-34 再構築ペイン

注： 四重極システムを使用して取得したデータについては、ペイン内でのタイトルは

「再構築、ピーク幅 [値]」のようになります。

10.再構築されたタンパク質のピークを選択します。

再構成タンパク質を生成するために選択したスペクトルには、手動再構築の垂直マーカが

追加されます。
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図 6-35 手動再構築マーカー付きスペクトル

概要

このセクションでは、以下のタスクについて説明されました。

• 消化タンパク質サンプルからの MS/MS スペクトルデータを手動配列する。

• ペプチドフラグメントを使用して、手動で配列決定されたスペクトルをリンクする。

• マーカー（手動再構築マーカー）を追加し、スペクトルに対して、所定の質量における理

論m/z比の位置を注記する。

• スペクトルからマーカーを削除します。

• 理論的なペプチド配列の情報を取得する。この情報は、指定したタンパク質の、ユーザが

定義した酵素的切断から生じます。
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• LCMS ペプチド再構築により、スペクトルのピークを識別し、識別されたスペクトルピー
クからデコンボリューションを行う。

• [Protein（タンパク質）] ペイン上の理論上の情報を、再構成されたピークリストにリンク
する。

• 蛋白質タンパク質の平均質量（分子量）を取得する。
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